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Introduction
 

Thank You!

Thank you for selecting AFMatic for your off-aircraft performance computation needs.  At Tybee
Jet, we are committed to providing you with the most reliable software and service available. 
Please contact us whenever you have questions about the software, suggestions for future
upgrades, or customer service needs.  It will be our pleasure to serve you.  Email anytime, or
call during office hours, Monday through Friday, 9:00 AM until 6:00 PM, Central Time.  Current
contact information can always be found in AFMatic on the Help menu, Contact function.

Overview

As the name suggests, AFMatic is an automatic Airplane Flight Manual, a computer program
that calculates takeoff and landing performance using the data provided in the AFM (and much
more).  Included in the software package is the worldwide airport database, described below. 
There is no longer any need for digging through approach plates or Airport Facilities Directories
for runway data!  All you have to do is enter the airport identifier (ICAO or IATA) and the
database will provide the information, and if you don't know the airport identifier, you can easily
search for the airport.  AFMatic also allows you to enter and store takeoff obstacle data, as
many as 20 obstacles per runway.  These data may be obtained from Airport Obstruction
Charts or Aeronautical Information Publications, or from Jeppesen OpsData in electronic form.
 AFMatic can import the Jeppesen obstacle files directly, eliminating the need for typing in the
data.

AFMatic is updated on the AIRAC 28-day revision cycle.  The latest worldwide airport database
is provided, along with all revisions to the Airplane Flight Manual data and any changes to the
software itself.  The AFMatic update service is offered on a subscription basis, renewable
annually.

Worldwide Airport Database
AFMatic includes a worldwide airport database, which is made up of two components.  The
domestic  airport database is provided by the Federal Aviation Administration (FAA).  This
database contains approximately 4,000 airports in the United States and its territories, having
more than 11,000 hard-surfaced runways that are at least 3,000 feet in length.  The Jeppesen
NavData database contains over 3,600 non-U.S. airports, with more than 8,400 hard-surfaced
runways that are at least 4,000 feet in length.  For each airport, location and position, elevation,
time zone, and available fuel types and services information are provided.  For each runway,
position, length, slope, runway surface, PCN when available, and lighting are provided.

Physical obstacles and SID / DP required climb gradients are not included in the worldwide
airport database.  The user may easily add these data, and they will be stored in the user
airport database for later use in calculations.
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Install
 

Requirements

AFMatic is a 32-bit Windows program, making full use of the capabilities of Microsoft's
Windows operating systems.  It has been designed for, and tested on, Windows 95, 98,
Millennium Edition, NT, 2000, and XP operating systems, and requires one of them.  It is not
compatible with previously available operating systems, such as MS-DOS and Windows 3.1. 
Windows is designed for use on Intel compatible personal computers.  There are some
software emulators available that allow Windows programs to be executed on other computer
hardware, such as the Apple Macintosh.  AFMatic has been briefly tested with Virtual PC for the
Power Macintosh, and found to be fully functional.  However, extensive testing has not been
conducted, and no guarantees are made with respect to the functionality of AFMatic under
software emulation.

AFMatic requires approximately 10 MB of hard disk space for a full installation.  A CD-ROM
drive or a connection to the internet is required for installation of the software.  After installation,
the CD-ROM is not required to run AFMatic.  

Internet Download

AFMatic updates may be downloaded from the Tybee Jet website, in addition to the normal
distribution by CD-ROM.  This may come in handy for those times when you will be away from
your home base for an extended period, or for international operators whose delivery of the CD-
ROMs is delayed by customs processing.

To begin using the internet download service, send an email to support@tybeejet.com, with a
list of email addresses to which you would like the notifications to be sent.  When each AFMatic
update is ready for download, an email message will be sent to your list of recipients, including
instructions for downloading the update as well as your current installation serial number and
aircraft code for each aircraft for which you have an AFMatic subscription.  Then you just
download the AFMsetup.exe file and execute it to install the latest update.

Install Procedure

Place the AFMatic distribution CD-ROM in the CD-ROM drive.  If you have the Autorun feature
enabled on your computer, the setup program will start automatically.  If it does not, then from
the Windows Start menu, select RUN.  Type in D:AFMSETUP.EXE, where D is the letter
corresponding to your CD-ROM drive.  The setup program will lead you through the steps
required for installation.  During the process you will be able to specify the disk and directory
where AFMatic will be placed.  You will also be asked to provide your name, your company's
name, and a serial number.  The serial number is critical to the operation of AFMatic, so it is
important that you type it in correctly.  You will find the serial number on the card that
accompanies the installation disk.  DO NOT LOSE THIS CARD!  The serial number printed on
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it will be required again if you need to reinstall the program for any reason, or if you need to
install it later on another computer.

Updates may be installed in the same directory as the previous version, without uninstalling the
old version.  The installation will overwrite the old distribution files.  However, the UserApt and
ProgIni files, described below, and any other files that are not a part of the software distribution,
will be left undisturbed.

Once the installation is complete, you may remove the CD-ROM from the computer.  AFMatic
execution does not require the CD-ROM, since all of its required files are stored on the hard
disk.

Files

After installation, the directory in which you installed AFMatic will contain a number of files.  A
brief listing follows:

AFMatic.exe This is the program executable

AFMatic.ini Program initialization data, DO NOT EDIT MANUALLY!

Apt.dat Worldwide airport database

Apt.inx Worldwide airport database index

XXXXX.dat Aircraft data files, XXXXX is aircraft type and certification, e.g.
G5FAA

XXXXX.inx Aircraft index files, named to match the data files

AFMatic.hlp Online help file

AFMatic.cnt Online help file

AFMatic.pdf Program documentation in Adobe Acrobat (PDF) format

Readme.txt Information about the current release, including What's New

License.txt Software end user license agreement

Unins000.exe Uninstaller program executable

Unins000.dat Uninstaller data file

After the program is executed for the first time, several new files will be created, as follows:

UserApt.dat User storage for airport, runway, obstacle, and SID/DP data

UserApt.inx Index for user stored airport, runway, obstacle and SID/DP
data
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Progini.dat Preferences and aircraft data (serial number specific)

Progini.inx Index for preferences and aircraft data

It is recommended that you back up the UserApt and ProgIni files periodically, since they
cannot be restored by reinstalling from the AFMatic distribution disk.  If you are installing
AFMatic on several computers, you may want to use one computer to input all of your obstacle
and SID information, and then copy the UserApt files to the other computers that are running
AFMatic.  The same is true of multiple aircraft serial numbers: just input the data on one
computer and then copy the ProgIni files to the others.

Installation Serial Number and Aircraft Code

During the installation process, you will be asked to enter your name, your company name, and
a serial number.  Your name and company name will be used in the header of printouts of
calculations that you make with AFMatic.  The serial number that you will need in order to
complete the installation is found on the card that is enclosed with the AFMatic CD-ROM, and
is labeled "Installation Serial Number".  This number is a part of the program's security system,
which ensures that users of the software have purchased a software license for use of the
program.  If there is an error in the Installation Serial Number, you will be presented with an
opportunity to correct the number during the installation.  Note: The characters contained in
the Installation Serial Number include the numbers 0-9 and letters A-F only.  There are
no letters I, O, or Z.

In addition to the installation serial number, each aircraft for which you have purchased a
license to use AFMatic will require an aircraft code to be entered at the time you define the
aircraft characteristics in the New Aircraft editor.  This aircraft code is located on the card that
is enclosed with the AFMatic CD-ROM, and is labeled "Aircraft Code".  It will have an aircraft
serial number to identify the aircraft with which it is to be used.  Embedded within this aircraft
code is the aircraft serial number, aircraft type, and certification basis.  It is not possible to
configure the program for more than one aircraft using a single aircraft code.  Note: The
characters contained in the Aircraft Code include the numbers 0-9 and letters A-F only.
 There are no letters I, O, or Z.

Run For The First Time
 

Do This First

The first time you execute AFMatic, you will automatically be placed in the New Aircraft editor
so that you may enter the specifics for your aircraft.  See the section on New Aircraft later in
this documentation for instructions on how to use this function.  After entering the aircraft
specifics, you are ready to begin using AFMatic.
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Primary Functions

To make performance or weight and balance calculations, or view weather reports and
graphics, select the appropriate function by clicking on the buttons arrayed across the top of
the main program window.

Database Menu

You may access the database editors to enter airport / runway, obstacle, or SID data, and
import obstacle data, by selecting the appropriate function from the database menu.

Options Menu

Select the aircraft, by tail number, from those that you have configured and saved with the New
Aircraft Editor.  Toggle the visual component hints.  Set program preferences with the
Preferences Editor.

Help Menu

The help menu provides access to the online help system through the Help Topics function,
general information about AFMatic and revision information on the data it uses through the
About function, and information on contacting Tybee Jet through the Contact function.

Visual Component Hints

Nearly every visual component of AFMatic has some additional information which can be
viewed by simply placing the cursor over the component.  The hint will be displayed on the
status line of the main program window, as well as attached to the tail of the mouse cursor.

Uninstall
 

Should you need to uninstall the program for any reason, the means to do so has been
provided.  To remove AFMatic from your computer, from the Windows Start menu, select
Programs, then AFMatic, and click the Uninstall AFMatic item.  Alternately, from the Windows
Start menu, select Settings, then Control Panel, and double-click on the Add/Remove
Programs icon.  You will be presented with a list of installed programs.  Select AFMatic, and
then click the Add/Remove button.   AFMatic will be removed from your computer.

There will be several files left behind in the directory where AFMatic was located, specifically
the UserApt and ProgIni files, as well as the AFMatic.ini file.  These files were created by
AFMatic after installation, and contain program initialization information and user-provided
airport/runway/obstacle/SID data.  They may be deleted if you do not wish to save the user-
provided data for later use.
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If you have moved AFMatic from the directory where it was originally installed, the uninstall
procedure will fail, since it is unable to find the location of the files.  In this event, you may
manually delete the files in the AFMatic directory.  This will not completely remove the program,
however, since there are also items on the Windows Start menu.  These may be manually
removed.

Primary Functions

General
 

The primary functions of AFMatic are accessed by pressing one of the buttons arranged
across the top of the screen, just below the menu bar.  Upon selecting any of these functions,
you will see the input and output for that function formatted with a notebook metaphor, having
tabs across the top for the major subdivisions within the primary function.  Clicking on any of
these tabs will change the display to show the contents of that page.  The results page is only
shown after a computation has been performed, and is disabled at any time that any of the
associated inputs is changed.  To perform the computation, when you have established the
desired inputs for the calculation, press the Compute button located at the right end of the
primary function buttons.  The computation will be performed, and the results displayed.

Data may be entered in any order, and will remain in the input fields after the computation is
performed, so that you may return to the inputs to view them, or make changes and
recompute.  You may freely move between notebook pages within a primary function, or switch
back and forth between functions.

Takeoff Computation

General
 

The takeoff computation is the centerpiece of the program.  It gives you the ability to analyze
takeoff performance from any runway in the world, including optional obstacle clearance and
SID/DP minimum required climb gradient compliance.  Airport and runway are selected from
the worldwide airport database, or from the user database, which contains any runways that
the user enters and saves.  Atmospheric data are entered, and the aircraft configuration is
defined.  Then the Compute button is pressed, and a half-hour of manual labor is performed for
you in a few seconds time.

Airport
 

General

On the airport page, select the airport and runway which will be used for computation, make
adjustments to runway length (for example, if a NOTAM closes a portion of the runway for
construction), add obstacles, and select a SID/DP for a required climb gradient check.
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Airport Identifier

Enter the 4-letter ICAO identifier, or the 3-letter IATA identifier.  Click on the ICAO or IATA button
to select which identifier has been specified.  Press Enter or click on the Retrieve button to
retrieve the airport from the database.  You may view the airport information by clicking on the
View button, either before or after pressing the Retrieve button.  When the airport has been
retrieved, the Airport / Runway Info box will contain the airport name and city, state, and
country.  The text on the Retrieve button will change color from red to green when an airport
has been read into memory.  Click the Search button to search for an airport in the database by
name, city, or location.

Runway

When the airport data are retrieved from the database, the runway identifier drop-down list is
filled with a list of the runways that are available for this airport in the database.  Select the
desired runway from this list by clicking on it or using the arrow keys to highlight your choice,
and then press Enter or click on the Retrieve button to retrieve the runway data from the
database, or the View button to retrieve the data and view it.  When the runway has been
retrieved, the Airport / Runway Info box will contain the runway identifier, length, and end
elevation.  The text on the Retrieve button will change color from red to green when a runway
has been read into memory.

Shorten Runway

You may shorten the runway at either the brake release end or the liftoff end.  This is useful for
accounting for a partial closure for construction, for example, or for an intersection takeoff. 
Line up distance is included as a means of accounting for the distance between the physical
end of the runway and the nosewheel of the airplane.  Its default setting is 100 feet, and it may
be adjusted permanently in the Preferences dialog, accessed through the Options menu. 
Runway length is adjusted by all three of these entries, and obstacle distance from brake
release is adjusted by the line up distance and shortening at the brake release end of the
runway.  Units for all runway lengths are in feet.

Obstacles

If there are any obstacles in the user database for the selected runway, the number of
obstacles found for this runway will be shown, and the Use Obstacles check box will be
checked.  You may decide not to include obstacles in the calculation, if for example it is a clear
day and they are easily avoided.  In that event, click on the Use Obstacles check box to
deselect it.  You may also add up to 5 temporary obstacles, by clicking on the Add Temp Obs.
button.  This will open a dialog box for adding the obstacles.  Be sure to add obstacles
beginning on the top line of the temporary obstacle table, since the first line having a zero for
the distance value denotes the end of the temporary obstacles.  To add obstacles permanently
to the user airport database, select the Edit Obstacle Data function from the Database menu.
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SID / DP

SID (Departure Procedure) required climb gradients are not included in the airport database
provided with AFMatic, but may be added to the user database by using the Database / Edit
SID function.  If there are any SIDs in the user database for the selected runway, the number of
SIDs found for this runway will be shown.  The Use SID check box will initially be unchecked,
indicating that no SID will be used for the calculation.  To add a SID required climb gradient
check to the computation, select the SID from the list under the Use SID check box, and click
on the Use SID check box to activate the calculation.  To add SIDs permanently to the user
airport database, select the Edit SID Data function from the Database menu.  The methods
available for computing SID required climb gradient performance are listed below the list of
available SIDs.  Select the desired climb profile to be used in the calculation from the list.  Note
that the SID climb procedures that are available for the GIV and GV are not available to be used
in conjunction with calculations involving physical obstacles.  To compute a SID at the same
time as computing physical obstacle clearance, you must select either the Treat as Obstacle
method or the Simple Gradient method.  This is a limitation imposed by the Operational
Information Supplement.  The default SID method may be set using the aircraft editor, by
selecting the Edit Aircraft function from the Database menu.  For the military airplanes only (C-
37 and C-20), below the SID method list, you may select an amount by which the SID gradient
is to be reduced, either no reduction, 48 FT/NM (0.8%) reduction, or 96 FT/NM (1.6%)
reduction.

A note on SID computation methods:  Operators use a number of different methods of
checking compliance with SID required climb gradients.  AFMatic supports four of them.  The
first is the SID Climb – 1 Engine method (known as V2-Direct - 1 Engine for C-37A and C-20),
which is described in an Operational Information Supplement for the GIV and GV.  In this
method, the aircraft stays in the second segment configuration and continues climbing until the
SID altitude has been reached.  The second method, SID Climb – All Engines (V2-Direct - All
Engines for C-37A and C-20), is flown in the same way, but assumes all engines are operating.
 Neither of these methods may be used when physical obstacles are to be included in the
calculations, as discussed in the OIS.  The third method, Treat As Obstacle (1500-Accel for C-
37A and C-20), converts the gradient and "up to" altitude into an imaginary obstacle located at
the end of the SID climb.  Then, the engine-out net takeoff flight path is analyzed for obstacle
clearance in the same way that other obstacles are analyzed. The last method is the simplest.
 The Simple Gradient method determines in which segment of the net takeoff flight path the SID
"up to" altitude occurs, and compares the climb gradient available in that segment with the
climb gradient required by the SID.  This method does not take into account the path that the
airplane takes in reaching that point, and should therefore be used only in those cases where
one of the other methods cannot be used.

Net or Gross, and why should I care?

So, what's all the fuss about net or gross performance, and what difference does it really
make?  Gross performance is what the airplane will actually do, assuming the engines and
other systems are performing according to spec, and the pilot flies the procedure as specified.
 The FAA mandates that obstacle clearance performance be presented in the Airplane Flight
Manual which has been degraded by 0.8% climb gradient, which is equivalent to 48 FT/NM. 
Data which have this performance margin built in are said to represent net performance.  All
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calculations for clearing physical obstacles are based on net performance, and use the
obstacle clearance charts from the AFM.  The Treat as Obstacle and Simple Gradient methods
of SID/DP clearance are also based on net performance.  The SID Climb - 1 Engine and SID
Climb - All Engines methods are calculated using the data from the SID climb OIS, and are
based on gross performance.  Why are the SID climb procedures based on gross
performance while other obstacle clearance is based on net?  Because civilian SID required
climb gradients contain an additional 0.8% performance margin.  In order to keep you from
having to overcome redundant performance margins, which would be overly conservative and
rob you of a significant amount of utility from your airplane, the Gulfstream engineers have
removed the 0.8% performance margin from the obstacle clearance data in the SID climb
tables.  Thus, the SID climb data are gross, while the obstacle clearance data are net.  In the
case of physical obstacle clearance, the 0.8% margin is accounted for in the performance
data, and in the case of a SID required climb gradient, the 0.8% margin is accounted for in the
SID gradient itself.  In either case, your calculations will include the FAA required 0.8%
performance margin, and if you are using the Treat as Obstacle or Simple Gradient methods
for SID clearance, you will have a 1.6% performance margin.  Please feel free to contact Tybee
Jet if you would like to discuss this in more detail.

Atmospherics
 

General

The Atmospherics page provides a place to input information relating to the atmospheric
conditions at the time of takeoff.  Ambient temperature, altimeter setting, wind speed and
direction, and FLEX limiting temperature may be input here.

Temperature

Airport ambient temperature is entered here.  You may specify the temperature in either
degrees Celsius or Fahrenheit.  Click on the appropriate button for which.  Temperature is
limited to the range shown in the AFM Limitations for the pressure altitude specified.  If the
temperature is outside the range, you will be notified at the time of calculation that the
temperature specified is outside the limits.

Altimeter Setting

Specify the altimeter setting, and click on the appropriate units of measurement.  Altimeter
setting is used to adjust the field elevation to pressure altitude for use in the calculations.

Wind Direction and Speed

Specify the wind direction, in degrees magnetic.  For those few airports in the far north that
make use of true instead of magnetic bearings, enter the wind direction in degrees true.  The
runway direction in the database for these airports is in true bearing, so the headwind and
crosswind components will be resolved correctly.  Specify wind speed and gust speed.  Select
the units of measurement for the input wind speed by clicking on the appropriate button.
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FLEX (Reduced Thrust) Takeoff

You may enable or disable calculation of FLEX takeoff performance by checking the Compute
FLEX Takeoff box.  In addition, you may elect to limit the assumed temperature in the
calculation, in order to introduce conservatism, by checking the Restrict Assumed Temp. box. 
Then enter the temperature to which you wish to restrict the calculations, in the same units as
the ambient temperature.

Runway Condition

 

C-37A & C-20
Enter Runway Condition Reading (RCR) and Runway Surface Contamination (RSC).  RCR is
limited to a range of 5 (icy) to 23 (dry).  RSC is limited to a range of 0.00 to 0.30.

Gulfstream V, IV, IV-SP, III, and IIB
Contaminated runway performance may be computed, using the data from the Contaminated
Runway Operational Information Supplement.  Select runway condition from Dry, Wet, or Icy. 
Wet or Icy may optionally have contamination.  If there is contamination present, select the type
of contamination and enter the depth of the contaminant.  Note: Contaminated runway data
presented in the Operational Information Supplement published by Gulfstream are 
Advisory Only, and are not FAA approved.

Gulfstream 350, 450, 500, and 550
Contaminated runway performance may be computed, using the data from the Contaminated
Runway Operational Information Supplement.  Select runway condition from Dry, Wet, or
Contaminated.  If there is contamination present, select the type of contamination and enter the
depth of the contaminant.  Note: Contaminated runway data presented in the Operational
Information Supplement published by Gulfstream are Advisory Only, and are not FAA
approved.

Configuration
 

General

The configuration page allows you to enter information pertaining to the configuration of the
airplane.  Weight, flap setting, anti-ice, anti-skid, ground spoilers, and power setting method are
input here.

Weight

Takeoff weight is specified, and the appropriate units are selected by clicking on the units
button.  If the weight field is left at its default value of 0, the maximum takeoff gross weight will
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be substituted when the calculation is made.  Thus, this is a shortcut for determining the
maximum weight for the specified conditions.  If the specified weight is greater than the
maximum takeoff gross weight, you will be notified that you exceed the limiting weight and must
reduce it.  If the weight specified is less than the minimum weight for which flight manual data
are available, that minimum weight will be substituted when the calculation is made.

You may fill in the weight with the takeoff weight from a previously computed weight and
balance calculation, by clicking on the W&B TOGW button in the weight input box.  If a takeoff
gross weight is not available, this button will be disabled.

Flaps

Select the flap setting for takeoff from the available choices in the drop-down list by clicking on
the flap setting. The calculation will be made for the selected flap setting.  If you check the
Optimize box and the takeoff is limited to a weight that is less than the specified weight, the
other flap setting will be computed.  Whichever setting results in the highest takeoff weight will
be presented in the results.  If Optimize is not checked, calculation will be made with the
selected flap setting only.

Anti-ice

Select the anti-ice configuration by clicking on the appropriate button.  If the temperature is
outside the limit for the selected configuration, you will be notified of the error at the time of
calculation.

Anti-skid

Select the anti-skid configuration by clicking on the appropriate button.  If this results in a
configuration that is prohibited by the limitations, you will be notified of the error at the time of
calculation.

Ground Spoilers

Select the ground spoilers configuration by clicking on the appropriate button.  If this results in a
configuration that is prohibited by the limitations, you will be notified of the error at the time of
calculation.

Power Setting

Select power setting method, EPR or LP RPM.

Increased Rotation Speed (C-37A & C-20)
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Increased rotation speed may be specified if desired.  This will be included in field length
computations.  Range of the input is from 0 to 10 knots.

Environmental Control System (G550 & G500)

Environmental control system (ECS) may be selected on or off as desired.

Results

General
 

Upon clicking the Compute button, the takeoff calculation is performed.  When the calculation
is complete, the Results page is enabled and displayed.  It contains the results of the
computation for both rated thrust and reduced thrust.  There are 9 screens full of output
information available.  Initially, the Basic screen is displayed.  You may access the other output
screens by clicking the buttons at the bottom of the Results page.  Results may be printed by
selecting Print from the File menu, or pressing CTRL-P.  Results may be saved to a text file by
selecting Save from the File menu, or pressing CTRL-S.

Basic
 

Rated Thrust

 

Standard Output
The flap setting that was used for the displayed calculation is shown.  This may differ from your
selected flap setting if you checked the optimize box and the selected weight was higher than
the limits allow.  The ambient temperature is shown in the selected units.  Next is the Maximum
Takeoff Weight.  This weight represents the maximum that could be taken off within all
limitations.  Next, a description of the limiting condition is shown.  This tells you what factor is
most limiting.  The actual takeoff weight is shown next.  This will be the lesser of the weight
specified on the Configuration page and the limiting weight.  Next, you will see the takeoff
speeds.  V1 is shown first. In the Preferences function of the Options menu, you may specify
which V1 will be displayed, choosing from the minimum, maximum, or balanced.  Whichever
you choose, you may see all three by placing the cursor over the V1 speed value.  VR, V2,
VFS, and VSE are all shown next.  When increased rotation speed is used for the C-37A or C-
20, the increase is included in the displayed VR and V2 speeds, and the increase is noted in
parentheses.  VRef is shown for an immediate return for landing, using the normal landing flap
setting and landing on the same runway under the same atmospheric conditions as were
present for the takeoff.  In the event that the landing field length required exceeds the landing
field length available for an immediate return to the same runway, a red asterisk will appear
beside the VRef speed, and the Weight and Landing button text will change to red to lead you to
additional information.  The landing will not limit the takeoff weight.  The landing is computed
based on a weight that is reduced by the estimated fuel for the pattern circuit.  Finally, the
takeoff EPR for rated thrust, or LP RPM if selected, is shown, accompanied by Climb EPR for
those aircraft that may use the Quiet Flying procedures.



Primary Functions 13

© Copyright 1998-2016 Tybee Jet Corporation

Additional Information
You may view additional program output by placing the cursor over the output values that are
displayed.

Flap Setting: Tells whether the selected flap setting was used, or if the
alternate setting was used to increase the available takeoff
weight.

Actual Temperature: Temperature difference from standard day, pressure
altitude, density altitude, headwind and crosswind
components.

Max Takeoff Weight: The maximum structural takeoff weight, and limiting
weights for takeoff distance, climb, tire speed, brake
energy, obstacle clearance, and SID/DP clearance.

Limited By: If takeoff is impossible, a brief message indicating the
reason is shown.

Actual Takeoff Weight:Takeoff field length, accelerate-go distance, and
accelerate-stop distance.

V1: Minimum V1, Balanced V1, and Maximum V1 are shown. 
For aircraft with brake inspection speed, it will be shown if it
is less than Maximum V1.

VR: For C-37A or C-20, if Increased Rotation Speed is used, it
is noted here.

V2: Altitude up to which V2 should be maintained and elevation
of highest obstacle and SID/DP up to altitude, if applicable.

VFS: No additional information.

VSE: No additional information.

VRef: Landing field length for an immediate return.

Rated EPR: LP RPM.

Impossible Takeoff
Whenever a takeoff is impossible at any weight, the Maximum Takeoff Weight will be set to
zero, along with the Actual Weight and all of the speeds and power setting.  The complete list
of limit weights is still available by placing the cursor over the Maximum Takeoff Weight value,
and a more detailed message may be viewed by placing the cursor over the Limited By value. 
A message will also pop up to inform the user.

FLEX Thrust

 

Standard Output
If the FLEX takeoff is computed, the results are shown on the right side of the Results page. 
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Flap setting is first, and will always match the flap setting for the rated thrust takeoff.  Next
comes the assumed temperature.  This is the maximum temperature at which the actual
weight from the rated thrust takeoff may be taken off within the limitations.  Next comes the
description of the factor that is most limiting, followed by the actual weight, which will match the
actual weight in the rated thrust takeoff.  Then follow the V-speeds, matching the weight and
assumed temperature.  Lastly, the FLEX EPR is shown, accompanied by Climb EPR for those
aircraft that may use the Quiet Flying procedures.

Additional Information
You may view additional program output by placing the cursor over the output values that are
displayed.

Flap Setting: Tells whether the selected flap setting was used, or if the
alternate setting was used to increase the available takeoff
weight.

Assumed
Temperature:

The maximum temperature allowed, and limiting
temperatures for takeoff distance, climb, tire speed, brake
energy, obstacle clearance, and SID/DP clearance.

Limited By: No additional information.

Actual Takeoff Weight:Takeoff field length, accelerate-go distance, and accelerate-
stop distance.

V1: Minimum V1, Balanced V1, and Maximum V1 are shown. 
For aircraft with brake inspection speed, it will be shown if it
is less than Maximum V1.

VR: For C-37A or C-20, if Increased Rotation Speed is used, it
is noted here.

V2: Altitude up to which V2 should be maintained and elevation
of highest obstacle and SID/DP up to altitude, if applicable.

VFS: No additional information.

VSE: No additional information.

VRef: Landing field length for an immediate return.

FLEX EPR: No additional information.

Impossible Takeoff
There are a number of restrictions on FLEX takeoffs that can prohibit the use of a reduced
thrust takeoff, such as a wet runway, soft-surfaced runway, etc., as outlined in the FLEX
Appendix in the AFM.  In addition, there are several things that make a FLEX takeoff have no
value, for example, if the temperature spread between the ambient temperature and assumed
temperature falls on the flat part of the takeoff EPR curve, such that there is no reduction in
EPR, even though there is a significant difference in temperature. Whenever it is not possible
to make a reduced thrust (FLEX) takeoff, the FLEX output box will be hidden, and the message
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"Reduced Thrust Takeoff not possible:" will be displayed, followed by a line stating the reason
that the FLEX takeoff cannot be made..

Weight
 

Rated Thrust

Maximum weights are listed for the respective categories.  The most restrictive of these is the
maximum takeoff weight that is displayed on the Basic screen.  If obstacle or SID/DP
clearance are not computed, the numbers are replaced with N/A.

FLEX Thrust

Maximum temperatures are listed for the respective categories.  The most restrictive of these
is the assumed temperature that is displayed on the Basic screen.  If a FLEX thrust takeoff
was not computed, a message will be displayed.

Loading

The basic operating weight, which was entered with the New Aircraft function, is displayed. 
The payload from a weight and balance computation, if one was done, is shown next.  The fuel
load at max weight is computed by taking the maximum allowable weight, adding start/taxi/
takeoff fuel, and subtracting basic operating weight and payload.  Similarly, the fuel load at
actual weight is computed by taking the actual weight, adding start/taxi/takeoff fuel, and
subtracting basic operating weight and payload.

Runway
 

Input

The runway length, slope, clearway, and stopway that were used in making the computations
are displayed.  Runway length is TORA, as shown in the runway viewer, minus lineup distance
and runway shortenings that were entered on the Takeoff Airport page.  Clearway is TODA
minus TORA.  Stopway is ASDA minus TORA.  If the runway was shortened at the liftoff end,
both clearway and stopway will be set to zero, in the assumption that these are not available for
this takeoff.

Rated Thrust

For minimum V1, maximum V1, and V1 for balanced field length, the accelerate-go and
accelerate-stop distances are shown.  If the balance point would be higher than the maximum
V1, the balanced V1 will be set to maximum V1.  Likewise, if the balance point would be lower
than minimum V1, the balanced V1 will be set to minimum V1.  If there is no V1 range available
for this takeoff, all three speeds, and their associated distances, will be the same.
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FLEX Thrust

For minimum V1, maximum V1, and V1 for balanced field length, the accelerate-go and
accelerate-stop distances are shown.  If the balance point would be higher than the maximum
V1, the balanced V1 will be set to maximum V1.  Likewise, if the balance point would be lower
than minimum V1, the balanced V1 will be set to minimum V1.  If there is no V1 range available
for this takeoff, all three speeds, and their associated distances, will be the same.  If a FLEX
thrust takeoff was not computed, a message will be displayed indicating the reason.

Gradient / SID
 

Rated Thrust

Climb gradient available is shown for second segment, final segment, and enroute single
engine climb at an altitude of 1500 feet above field elevation.  These gradients are expressed in
percent.  To see the gradient expressed in feet per nautical mile, place the cursor over the
percent value and the FT/NM value will appear as a hint on the status line.  These gradients
represent engine-out net performance.

FLEX Thrust

Climb gradient available is shown for second segment, final segment, and enroute single
engine climb at an altitude of 1500 feet above field elevation.  These gradients are expressed in
percent.  To see the gradient expressed in feet per nautical mile, place the cursor over the
percent value and the FT/NM value will appear as a hint on the status line.  These gradients
represent engine-out net performance.

SID / Departure Procedure

If SID required climb gradient clearance was computed for this takeoff, the specification for the
calculation is shown, including the SID name, transition (if any), required climb gradient, altitude
up to which the gradient must be maintained, and the calculation method.  The average
gradient between the reference zero point, corresponding to the end of the accelerate-go
distance, and the SID endpoint is shown, as well as the accelerate-go distance.  [Note: The
average gradient may be less than the required gradient.  This will happen when the takeoff is
not limited by field length.  The extra runway available is used to move the reference zero point
back down the runway, giving a lower required gradient necessary to reach the SID endpoint.] 
The maximum weight is shown at which this SID gradient can be cleared at the ambient
temperature.  If a FLEX thrust takeoff was computed, the maximum temperature is shown at
which this SID gradient can be cleared at the actual weight.  For the military aircraft (C-37 and
C-20), if the gradient was reduced by using the SID gradient reduction selection, the amount of
reduction from the SID required climb gradient is shown.

Obstacle
 

If obstacle clearance was computed for this takeoff, a table is displayed showing the position of
each obstacle, an indication of whether that obstacle was within the envelope (ICAO or FAA)
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that was specified in the Preferences editor, and the height by which the Net Takeoff Flight
Path clears the obstacle.  Values are shown for rated thrust takeoff, and FLEX thrust if that was
computed.  The obstacle that is cleared by the least amount in the rated thrust takeoff is
highlighted for easy identification.  The minimum height that an obstacle will be cleared by is 35
feet.  Obstacles that are not within the computation envelope are not used in the calculations,
and the clearance is shown as N/A.  If any of the obstacles that were computed were entered
by the user as temporary obstacles, they will be at the bottom of the list, and a note will indicate
which ones they are.  If obstacle clearance was not computed, a message will be displayed in
place of the table.

Speed
 

For the rated thrust takeoff, minimum V1, maximum V1, and V1 for balanced field length are
shown, as well as V1MCG and VMBE.  For the Gulfstream IIB, III, C-20, IV-SP, or IV with
Dunlop brakes installed by ASC, VBI (brake inspection speed) is shown.  These speeds are
also shown for the FLEX thrust takeoff if it was computed.

Atmospherics
 

Parameters relating to the atmosphere are displayed, including airport elevation, altimeter
setting, pressure altitude, density altitude, the minimum and maximum temperatures allowable
at the given pressure altitude from the aircraft limitations, ambient temperature and its
difference from the International Standard Atmosphere, the headwind and crosswind
components, and the maximum crosswind based on the selected runway condition.  The
maximum crosswind is not the Maximum Demonstrated Crosswind, but is based on the
crosswind limit chart that appears in the contaminated runway operational information
supplement (OIS).

Landing
 

Landing information for an immediate return to the takeoff runway is displayed.  This includes
the landing distance available, landing distance required, threshold speed (VRef), approach
climb speed, landing climb speed, and landing weight.  Landing weight is computed by
subtracting the estimated fuel burn for a pattern circuit from the actual takeoff weight.

In the event that the landing for an immediate return would require more runway length than is
available on the takeoff runway, a message will appear, indicating that the actual takeoff weight
exceeds the landing field length limiting weight, and a red asterisk will appear beside the
landing distance required.  In addition, the text on the LANDING button will be changed to red. 
Normally, this would most likely be seen with a short, wet or icy runway.

Miscellaneous
 

Brake Cooling

Brake energy, predicted BTMS, cooling time, and fuse plug integrity zone are shown for the
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rated thrust takeoff, and for the FLEX thrust takeoff if it was computed.  This calculation
assumes that the brakes were cool before the rejected takeoff.  The cooling time shown is the
time required to cool the brakes to zero energy.  For a more detailed computation of brake
energy, including multiple stops, use the brake energy calculation available by clicking the
Miscellaneous button at the top of the main program window.

PCN

When data are available in the woldwide airport database for Pavement Classification Number
(PCN), a calculation will be made to determine the Aircraft Classification Number (ACN) and
the maximum weight that would result in ACN being less than PCN.  The maximum tire
pressure allowed is decoded from the PCN and shown.  If there is no PCN information
available, a message is shown.  If ACN is greater than PCN, a message is displayed in red
letters, and the text on the MISC button is changed to red.

Landing Computation

General
 

The landing computation gives you the ability to analyze landing performance from any runway
in the world.  Airport and runway are selected from the woldwide airport database, or from the
user database, which contains any runways that the user enters and saves.  Atmospheric data
are entered, and the aircraft configuration is defined.  Then the Compute button is pressed, and
the results are displayed.

Airport
 

General

On the airport page, select the airport and runway which will be used for computation, and
make adjustments to runway length (for example, if a Notam closes a portion of the runway for
construction).

Airport Identifier

Enter the 4-letter ICAO identifier, or the 3-letter IATA identifier.  Click on the ICAO or IATA button
to select which identifier has been specified.  Press Enter or click on the Retrieve button to
retrieve the airport from the database.  You may view the airport information by clicking on the
View button, either before or after pressing the Retrieve button.  When the airport has been
retrieved, the Airport / Runway Info box will contain the airport name and city, state, and
country.  The text on the Retrieve button will change color from red to green when an airport
has been read into memory.  Click the Search button to search for an airport in the database by
name, city, or location.

Runway
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When the airport data are retrieved from the database, the runway identifier drop-down list is
filled with a list of the runways that are available for this airport in the database.  Select the
desired runway from this list by clicking on it or using the arrow keys to highlight your choice,
and then press Enter or click on the Retrieve button to retrieve the runway data from the
database, or the View button to retrieve the data and view it.  When the runway has been
retrieved, the Airport / Runway Info box will contain the runway identifier, length, and end
elevation.  The text on the Retrieve button will change color from red to green when a runway
has been read into memory.

Shorten Runway

You may shorten the available runway length.  This is useful for accounting for a partial closure
for construction, for example.

Atmospherics
 

General

The Atmospherics page provides a place to input information relating to the atmospheric
conditions at the time of landing.  Ambient temperature, altimeter setting, wind speed and
direction, and flight in prolonged icing conditions are entered here.

Temperature

Airport ambient temperature is entered here.  You may specify the temperature in either
degrees Celsius or Fahrenheit.  Click on the appropriate button for which.  Temperature is
limited to the range shown in the AFM Limitations for the pressure altitude specified.  If the
temperature is outside the range, you will be notified at the time of calculation that the
temperature specified is outside the limits.

Altimeter Setting

Specify the altimeter setting, and click on the appropriate units of measurement.  Altimeter
setting is used to adjust the field elevation to pressure altitude for use in the calculations.

Wind Direction and Speed

Specify the wind direction, in degrees magnetic.  For those few airports in the far north that
make use of true instead of magnetic bearings, enter the wind direction in degrees true.  The
runway direction in the database for these airports is in true bearing, so the headwind and
crosswind components will be resolved correctly.  Specify wind speed and gust speed.  Select
the units of measurement for the input wind speed by clicking on the appropriate button.

Icing
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Flight in prolonged icing will result in a reduction in climb capability, which must be accounted
for in the approach and landing climb gradient calculations.  Select the icing condition by
clicking on the appropriate button.

Runway Condition

 

C-37A & C-20
Enter the Runway Condition Reading (RCR), with an input range of 5 (icy) to 23 (dry).  The
Distance selection box on the configuration page is removed, and is replaced by this Runway
Condition box on the atmospherics page.

Gulfstream V, IV, IV-SP, III, and IIB
Contaminated runway performance may be computed, using the data from the Contaminated
Runway Operational Information Supplement.  Select runway condition from Dry, Wet, or Icy. 
Wet or Icy may optionally have contamination.  If there is contamination present, select the type
of contamination and enter the depth of the contaminant.  Note: Contaminated runway data
presented in the Operational Information Supplement published by Gulfstream are 
Advisory Only, and are not FAA approved.

Gulfstream 350, 450, 500, and 550
Contaminated runway performance may be computed, using the data from the Contaminated
Runway Operational Information Supplement.  Select runway condition from Dry, Wet, or
Contaminated.  If there is contamination present, select the type of contamination and enter the
depth of the contaminant.  Note: Contaminated runway data presented in the Operational
Information Supplement published by Gulfstream are Advisory Only, and are not FAA
approved.

Configuration
 

General

The configuration page allows you to enter information pertaining to the configuration of the
airplane.  Weight, flap setting, anti-ice, anti-skid, ground spoilers, and power setting method are
input here.

Weight

Landing weight is specified, and the appropriate units are selected by clicking on the units
button.  If the weight field is left at its default value of 0, the maximum landing weight will be
substituted when the calculation is made.  Thus, this is a shortcut for determining the
maximum weight for the specified conditions.  If the specified weight is greater than the
maximum landing weight, you will be notified that you exceed the limiting weight and must
reduce it.  If the weight specified is less than the minimum weight for which flight manual data
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are available, that minimum weight will be substituted when the calculation is made.

Weight Limits

For normal preflight planning, it is expected that you will want to enforce the limitations, and not
compute results that exceed the landing limitations.  However, you may want to examine a
landing that is an immediate return after takeoff, or you may be in flight and need to land at your
current weight, regardless of the limitations.  This is accommodated by clicking on the Allow
Higher button, which will allow computations to be made at weights that are higher than the
landing limitations.

Flaps

Select the landing flap setting from the available choices in the drop-down list by clicking on the
flap setting.

Anti-ice

Select the anti-ice configuration by clicking on the appropriate button.  If the temperature is
outside the limit for the selected configuration, you will be notified of the error at the time of
calculation.

Anti-skid

Select the anti-skid configuration by clicking on the appropriate button.  If this results in a
configuration that is prohibited by the limitations, you will be notified of the error at the time of
calculation.

Ground Spoilers

Select the ground spoilers configuration by clicking on the appropriate button.  If this results in a
configuration that is prohibited by the limitations, you will be notified of the error at the time of
calculation.

Distance

Operators who must meet the requirements of FAR 135 or 121 for landing field lengths, FAR
91 subpart K fractional operators, or FAR 91 operators who want to add conservatism to the
calculations, may do so through the Distance box.  To compute the landing weight limitation
based on actual dry runway landing field length, select Landing Dist.  To compute based on the
Intended Destination Dry (or Alternate Wet or Dry) factored field length, select Intended Dry/Alt.
 To compute based on the Intended Destination Wet factored field length, select Intended Wet.
 Whichever method is selected will be the one that the field length limited weight will be based
on.  In any event, all three distances will be displayed in the results.  When the C-37A or C-20
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is the active aircraft, this Distance box is removed, and is replaced by the Runway Condition
box on the atmospherics page.

When contaminated runway performance from the Contaminated Runway Operational
Information Supplement is being computed, by selecting a wet or icy runway on the
atmospherics page, you should set the Distance to Landing Dist.  Otherwise, the combination
of  contaminated runway and factored field length would produce a field length limited weight
that would be confusing at the minimum, and perhaps even meaningless.  In the event you are
computing contaminated runway performance, and must observe the factored runway limits for
commercial operations, select the appropriate runway condition on the atmospherics page, set
Distance to Landing Dist, and when you view the results, the limiting weight will be based on
the contaminated runway computation.  Then, make sure that the appropriate factored runway
length is not greater than the runway available.

Increased Threshold Speed (C-37A & C-20)

Enter increased threshold speed, if desired.  This will be included in landing field length
computations. Range of the input is from 0 to 10 knots.

Power Setting

Select power setting method, EPR or LP RPM.  This is used in determining approach and
landing climb gradients.

Results
 

General

Upon clicking the Compute button, the landing calculation is performed.  When the calculation
is complete, the Results page is enabled and displayed.  Results may be printed by selecting
Print from the File menu, or pressing CTRL-P.  Results may be saved to a file by selecting
Save from the File menu, or pressing CTRL-S.

Limitations and Field Length

The flap setting used for landing computations is displayed, followed by the temperature used. 
As in the takeoff results, you may see the Delta ISA temperature by placing the cursor over the
temperature value.  Next, the maximum weight permitted by limitations is shown.  You may
view the list of all limiting weights that were computed by placing the cursor over the limiting
weight value, in the same way as is done in the takeoff results.  The maximum weight will be
set to zero if the landing cannot be made within the limitations at any weight, and a message
will pop up to inform the user.  The description of the limiting factor comes next, followed by the
actual weight that was used for the calculations.  If the Weight Limits box was set to Allow
Higher, the actual weight may be higher than the maximum weight.  In this event, there will be a
message notifying you that the actual weight exceeds the limitations.  The VRef is shown,
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followed by the landing distance and factored field lengths.  For the C-37A or C-20, VRef
includes any increased threshold speed that was specified, which is also shown in
parentheses, and a more detailed note may be viewed by placing the cursor over the VRef
speed.  Factored field lengths are not shown for the C-37A or C-20.  Wind components are
shown at the bottom of the screen.  For the C-37A & C-20, if the landing configuration is one for
which landing ground roll data are available, landing ground roll is displayed.  When data are
available in the worldwide airport database for Pavement Classification Number (PCN), a
calculation will be made to determine the Aircraft Classification Number (ACN).  If there is no
PCN information available, a message is shown.  If ACN is greater than PCN, a message is
displayed in red letters.

When contaminated runway performance is computed and factored field lengths are shown,
the factored field lengths are factored from the dry runway performance, so if you have
specified an icy runway, for example, the Landing Distance may be considerably higher than
the Intended Destination (Wet).

For aircraft having brake inspection requirements, if VBI is less than VRef, a message will
appear on the lower right side of the Results page informing you that "Brake inspection is
required for initial braking speed of xxx or greater".

Approach and Landing Climb

Approach and landing climb results are shown to the right of the field length results.  For each
of them, you will see the climb gradient at the actual weight, the speed to maintain during a
climb, and the maximum temperature at which you meet the minimum climb gradient
requirements.

Weight and Balance

General
 

General

AFMatic provides the means to do weight and balance computations.  Click on the Wt. & Bal.
Button at the top of the main window.  To make use of the weight and balance function, you
must first enter the basic operating weight and horizontal arm in the aircraft editor, as well as
the location of seats and additional storage areas.  If you haven't done that yet, refer to the New
Aircraft section of the documentation for instructions on how to set up the aircraft weights. 
However, if you have not yet set up the aircraft weight information, you may still do a
computation by entering the BOW and arm on the Loading page.

Here you will enter the information regarding weights for the current flight.  When you have
completed the data entry, click Compute, and the computation will be made and the results
displayed.
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Calculate

There are 3 methods of calculation available to you.  The first, called Zone Loading, is the
quickest way to do a full weight and balance calculation.  With this method, the specified
number of passengers are first loaded in the most forward seats they can occupy and a
calculation is done.  Then they are loaded in the most aft seats and another calculation is done.
 If the limits are not violated with either of these loadings, then it is safe for the passengers to sit
in any seats, in any distribution.  

The second method, called Assigned Seats, allows you to place each passenger in a specific
seat, and assign each passenger a weight.  When this method is selected, you will see a table
with the seat locations and passenger weights.

The final method, Weights Only, just adds up the weights, and doesn't perform any center of
gravity calculations.  This would be most useful for a computation with an airplane that hasn't
yet been set up in the aircraft editor, where you just want to compute a takeoff weight for use in
the takeoff computation.

Configuration

Select the configuration from the available list.  These configurations were set up in the aircraft
editor.  For most operators, only a single configuration is needed.  However, if you have the
ability to reconfigure the interior layout, you can set up as many as five different configurations
and select the appropriate one when doing the calculation.

Weight Units

Select the units you will be working with, either pounds or kilograms.  This will default to the
value you select in the preferences editor.

AC120-27E Compliance

When this box is checked, the calculations will comply with FAA Advisory Circular 120-27E,
"Aircraft Weight and Balance Control".  This includes curtailment of the center of gravity limits
to account for passenger and crew movement about the cabin, as well as use of average
weights.  Curtailment for passenger seating distribution is not necessary, because we check
worst case distribution for the zone loading method, and seats are assigned for the assigned
seats method.

Passenger Weights

The Passenger Weights selection is activated when AC120-27E compliance is selected.  This
allows you to select the weights to use in the calculations.  The first weights listed are from
Table 2-2, "Average Passenger Weights for Operators With a No-Carry-On Bag Program". 
Next are listed weights for use of Segmented Weights, as described in Section 4 of AC120-
27E, for % of male passengers ranging from 90 down to 50%.  Finally, a selection to allow
choosing between male, female, or child passengers, based on the summer weights from
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Table 2-2.

Winter Coats

The Winter Coats box may be checked to add 5 pounds to the weight of each passenger at the
seat location to account for the wearing of winter clothing.  However, if you expect coats to be
stored in a closet instead of at the seat, leave this unchecked and add the weight in the
Additional Storage location.

Basic Operating

This box displays the basic operating weight and horizontal arm that you entered in the aircraft
editor.  If you wish to make permanent changes, do so in the aircraft editor, or enter values for
this calculation only directly in the input fields.  Note that the horizontal arm must be entered as
inches aft of the datum.  An error message will be displayed if the arm is specified as percent
mean aerodynamic chord (% MAC).

Fuel

Enter the weight of fuel that will be on board at engine start in the Total field, and the amount of
fuel that will be consumed in the start/taxi/takeoff operation in the Start/Taxi/Takeoff field.  Start/
Taxi/Takeoff fuel may be permanently changed in the aircraft editor.  It is not necessary to enter
fuel in order to compute weight and balance, since the large cabin Gulfstream aircraft will be
within the fueled C.G. envelope at any fuel loading as long as it is within the zero fuel envelope.
 However, if you enter fuel, the C.G. will be computed at the fueled weights as well.  Fuel weight
may exceed the maximum shown in the AFM limitations when fuel is cold and dense.  This is
permissible, and will result in an information message.

Zone Loading and Weights Only
 

Passengers

Enter the number of passengers to be included in the calculation, and their average weight. 
Number of passengers does not include crew members that are accounted for in the basic
operating weight.  The default value for weight is 170 pounds, which may be changed in the
aircraft editor, and you may change this for the individual calculation.  The Seat In Order box
may be checked to cause the seats to be filled in the order that was specified in the aircraft
editor.  If this feature is used, the forward/aft worst-case seating will not be used, but
passengers will be seated in the specified seats only.

Baggage

Enter the number of bags that are stored in the baggage compartment to be included in the
calculation, and their average weight.  This number does not include crew baggage that is
accounted for in the basic operating weight.  The default value for weight is 30 pounds, which
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may be changed in the aircraft editor, and you may change this for the individual calculation. 
Note that if you have a fixed cargo weight to store in the baggage compartment, you may enter
that as 1 bag at the required weight.

Additional Storage

In the aircraft editor, you have the ability to specify up to 5 storage locations, giving them
names, locations, and limiting weights.  In the Additional Storage box, you may enter the weight
to be placed in each of these locations.  You will not be allowed to enter a weight that is greater
than the limit you have specified.  If you left the limit at its default value of zero in the aircraft
editor, then the limit will not be checked.  If you did not specify any additional storage locations
in the aircraft editor for this tail number, then the Additional Storage box will not appear.

Assigned Seat Loading
 

Passenger Seating

If a floorplan is available, and selected in the aircraft editor, it will be displayed below the
AC120-27E compliance options.  To use the floorplan, simply click a passenger seat and a
passenger will be placed in that seat.  This will be evident by observing the Occupied column of
the seating spreadsheet in the lower right corner of the screen.  An X will appear for each
occupied seat, and the appropriate weight will be inserted.  The weight that is inserted will
depend on whether you are using AC120-27E compliance, and if so, the weight you have
selected in the Passenger Wts box.  If you aren't using these, the weight specified as the
default in the aircraft editor will be inserted.  You may change each passenger's weight to
another value if desired.

If no floorplan is available, the picture area will be blank, and passenger seats will be filled by
clicking on the Occupied box for the selected seat.

Baggage and additional storage locations may be entered at the bottom of the seating
spreadsheet.  It is not necessary for the Occupied column to be checked.

Results
 

General

The results of the weight and balance calculation are shown on the Results page.  Results
may be printed by selecting the Print item from the File menu, or pressing CTRL-P.  Results
may be saved to a text file by selecting the Save item from the File menu, or pressing CTRL-S.

Weight

Weights are shown in the units that were selected on the Loading page.  Weights are shown in
the order of weight build-up beginning with basic operating weight.  Payload is added to B.O.W.
to give zero fuel gross weight.  Fuel is added to Z.F.G.W. to give ramp gross weight.  Start/taxi/
takeoff fuel is then subtracted to yield the final takeoff gross weight.  If the fuel weight is zero, or
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is less than the start/taxi/takeoff fuel, then the ramp gross weight, start/taxi/takeoff fuel, and
takeoff gross weight are not shown, since they cannot be determined.  Fuel must be added for
these items to appear!

Center of Gravity - Zone Loading

The center of gravity results are shown in two columns.  The first is labeled "Fwd" and
represents passengers occupying the forwardmost seats in the cabin.  The second column,
labeled "Aft" represents passengers occupying the aftmost seats in the cabin.  All CG values
are shown in units of percent mean aerodynamic chord (% MAC).  Zero Fuel Center of Gravity
envelope limits are shown, which represent the forward and aft limits at the zero fuel gross
weight which is shown in the Weight output to the left.  The center of gravity range for zero fuel
gross weight is shown.  If the airplane is within the CG envelope for both loadings, then it will be
within the envelope for all passenger seating distributions.  Both ends of the zero fuel gross
weight CG range for both landing gear extended and retracted are checked against the limits,
and error messages will be displayed in the lower part of the results page if the limits are
violated.  You may notice that with either empty or full seats, the forward and aft loadings
present different CG numbers.  This is because the most restrictive of landing gear up or down
is shown for each, and one will be with gear up and the other with gear down.

Next, the CG is displayed for the takeoff weight shown to the left.  This CG is not limited by the
Zero Fuel CG envelope, so it is possible, and even likely, that TOCG values will fall outside the
ZFCG Limits, which is acceptable.

Finally, the recommended takeoff pitch trim setting is displayed, in trim units nose up or down. 
If you have not specified any fuel for the calculation, takeoff CG and pitch trim will not be
shown.  Fuel must be added for these items to appear!

ZFCG, TOCG, and Pitch Trim are computed by checking both landing gear down and up CG
location, and using the value for each that is most limiting.  Thus, if you are within the ZFCG
Limits as shown in the output, you are guaranteed to be within the limits in all phases of flight.

Center of Gravity - Assigned Seats

The center of gravity limits are shown in two columns, forward and aft.  The center of gravity
range for zero fuel gross weight is shown.  Then the Zero Fuel Center of Gravity is shown for
the aircraft with passengers sitting in their assigned seats.  The Takeoff Center of Gravity is
shown along with the corresponding Pitch Trim.  Once again, if the aircraft is within the CG
limits at Zero Fuel Weight, it will be within limits at any fuel loading.
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Miscellaneous Performance

Brake Cooling
 

General

Brake cooling calculations presented in Appendix C of the Airplane Flight Manual (or
Operational Information Supplement for earlier airplanes) are provided.  You may elect to
perform the calculation for a single brake application, or a combination of two stops.

Input

For the first brake application, you may compute the brake energy based on the peak BTMS
value displayed by the FMS after the stop, or you may compute it based on inputs of weight,
brakes on speed, pressure altitude, temperature, wind component, taxi distance, and taxiway
slope.  If you noted the groundspeed at the time of brake application from the FMS, you may
use that instead of an airspeed looked up from the AFM.  If you use groundspeed, the inputs for
pressure altitude, temperature, and wind are unnecessary, and will be made invisible.  The
optional second brake application uses the same input methodology as the first, with the
exception that the peak BTMS input is not provided, on the assumption that the analysis is
being done prior to the second stop.  Note that the wind component input is the head/tail wind,
and has a positive value for a headwind, and negative value for a tailwind.  You may clear the
inputs for each of the brake application calculations by clicking the Clear button at the bottom of
the page.  Press the Compute button to perform the calculations and view the results.

Results

The results of the brake cooling calculation are displayed at the bottom of the page, which will
be automatically scrolled down to the bottom.  The values shown are the brake energy
generated by each brake application, in million foot-pounds, the fuseplug integrity zone,
predicted peak BTMS for stops that are not computed based on BTMS, and the cooling time
required between stops.  In the event that only one stop is calculated, the cooling time
represents the time it will take to cool the brakes to zero energy, or ambient temperature. 
When two stops are computed, the cooling time represents the on-ground cooling time
required between the two stops to prevent the second stop from exceeding the maximum
brake energy total, as explained in Appendix C (or OIS).  Since a teardown inspection is
required when a stop is made in the Danger Zone, if the first stop falls in the Danger Zone, the
second stop will not be computed.  Results may be printed by selecting the Print item from the
File menu, or pressing CTRL-P.  Results may be saved to a text file by selecting the Save item
from the File menu, or pressing CTRL-S.

Pavement
 

General

Data for determining the acceptability of operation of aircraft on particular runways are provided
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by the manufacturer as non-FAA-approved information.  In the case of the Gulfstream V, it is in
the form of an engineering report that is included in the Gulfstream V Operating Manual.  Other
Gulfstream airplanes have this information in Operational Information Supplements.  Use of the
Pavement Classification Number information is a complex subject.  Please examine the
manufacturer's information to obtain an understanding of how it should be used in your
operations.  The following discussion focuses on the means of computing the Aircraft
Classification Number using AFMatic.

Input

PCN data are available in the worldwide airport database for approximately 1/3 of the runways
in the database.  To use the PCN data for the runway you are using, select "Database" in the
PCN Source box, then enter the airport identifier and click Retrieve, followed by selecting the
runway and clicking Retrieve.  If PCN data are available, the Pavement Type and Subgrade
Strength values will be set, and the PCN will be shown.  If PCN data are not available in the
database for this runway, you will be allowed to set the values for Pavement Type and
Subgrade Strength.  Rigid pavements are concrete and other similar pavements.  Flexible
pavements are asphalt and other similar pavements.  Then, select the strength of the
underlying subgrade soil.  CBR refers to the California Bearing Ratio, a measure of subgrade
strength for flexible pavements, while K is a measure of subgrade strength for rigid pavements.
 Subgrade strength may also be referenced by the letters A, B, C, and D, which correspond to
High, Medium, Low, and Ultra Low strength, respectively.  Enter the aircraft weight, in either
pounds or kilograms.  Most operators typically maintain a constant tire pressure for most
weight conditions, however, if the aircraft is operating on a surface which is marginal for
Pavement Classification Number, the tire pressure may be varied with weight in order to
optimize the floatation.  Select whether the tire pressure will be fixed or varied with weight. 
Select the pavement type, rigid or flexible.

Results

When you have completed the inputs, click Compute, and the results will be computed and
displayed.  The output will be the Aircraft Classification Number (ACN) and the Load
Classification Number (LCN).  In the United States, the ACN method is most frequently used,
but the LCN method is still used internationally.  Compare the results of the calculation with the
Pavement Classification Number (PCN) that applies to the runway surface in question to
determine whether the desired operation is possible.  If PCN data are available for this runway,
the comparison will be done for you, and when ACN is greater than PCN, a warning message
will appear in red.

Tools

General
 

Several non-performance-related functions have been provided for your convenience.  These
generally do not relate to airplane-specific data except as specified.  Tools are accessed by
clicking the Tools button at the top of the main program window.
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Wind Component Calculator
 

Input

Select the Wind page for the wind component calculator.  Here you may resolve a wind
direction and speed into its head/tail wind component and crosswind component for a given
runway.  You may determine the runway bearing either by database lookup or manual entry.  If
you select database lookup, you will retrieve the airport and runway data in the same fashion as
in the takeoff and landing performance calculations.  Click the Search button to search for an
airport in the database by name, city, or location.  With database lookup, the runway bearing
input field is protected, so you will be unable to modify it.  If you select manual entry, the airport
and runway identifier inputs will be made invisible, and you will enter the runway bearing
directly.  An input for the James Brake Index is provided to determine the maximum allowable
crosswind component based on the condition of the runway surface.  For the C-37A and C-20,
the JBI input is replaced by Runway Condition Reading (RCR).  Click the Compute button to
perform the calculation and view the results.

Results

The results of the wind component calculation will be displayed at the bottom of the page.  The wind
component is shown, with a notation of whether it is a headwind or tailwind.  The crosswind component is
shown with a note indicating which side the wind is coming from.  If the crosswind exceeds the maximum
demonstrated crosswind, a notation will be made on the right side of the display.  If the crosswind
exceeds the maximum allowable crosswind, based on JBI or RCR as appropriate, a note to that effect will
be displayed, which includes the maximum allowable crosswind.

Great Circle Distance Calculator
 

Input

Select the Great Circle page to compute the great circle distance between two points.  You
may either look up the two points in the airport database, or enter them manually.  If you look up
the latitude/longitude in the airport database, those input fields will be protected, so you will not
be able to modify them.  If you enter the latitude and longitude manually, the airport identifier
fields will be made invisible.  You may also enter a speed, and the time required to fly from the
departure airport to the arrival airport will be calculated.  Speeds of less than 1.0 will be
considered as zero wind Mach number, while speeds above 100.0 will be considered as
ground speed in knots.   Click the Compute button to perform the calculation.

Results

The results of the great circle calculation will be displayed at the bottom of the page.  The great
circle distance is shown, in both nautical miles and kilometers, as well as the initial true course
on the path between the departure airport and arrival airport.  Also shown is the distance along
a rhumb line (constant course) between the two airports, and the true course along that path. 
Finally, if a speed greater than zero was entered, the time to fly each course is shown, in
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hours, minutes, and seconds.

Timezone Calculator
 

Input

Select the Timezone page to determine the local time at an airport when the time at another
airport is input.  Start by entering an airport identifier for the first location and retrieving the
airport data.  Then enter the time at that airport, either in 12-hour format using the AM and PM
buttons, or in 24-hour format, ignoring the AM and PM buttons.  If daylight savings time is
recognized at the selected airport, a check box will be displayed for signifying that input time is
based on daylight savings time.  If the current date shown in your computer system falls within
the range of April 1 to October 31, the daylight savings time box will automatically be checked. 
If this is incorrect, just uncheck it.  Next, enter an airport identifier for the second location and
retrieve the airport data.  Like the first airport, a check box for daylight savings time will appear if
it is observed at that airport, and the box will be checked or unchecked based on the state of
the daylight savings time box for the first location.  Finally, click Compute to determine the local
time at the second location.

Results

The local time is shown for the second location, in 12-hour format, and the Universal
Coordinated Time (UTC) is shown in 24-hour format.  In addition, the time difference from local
time to UTC is shown for each airport as it is retrieved.

Sunrise / Sunset
 

Input

Select the Sunrise / Sunset page to determine local times for sunrise, sunset, moonrise,
moonset, dawn, and dusk.  Start by entering an airport identifier and retrieving the airport data. 
If needed, click the Search button to search for an airport in the database by name, city, or
location.  Then enter the date, either manually or by use of the popup calendar, which is
activated by clicking the calendar icon at the right edge of the date entry field. If daylight savings
time is recognized at the selected airport, a check box will be displayed for signifying that times
should be based on daylight savings time.  If the current date shown in your computer system
falls within the range of April 1 to October 31, the daylight savings time box will automatically be
checked.  If this is incorrect, just uncheck it.  Finally, click Compute to determine the rise and
set times.

The date input entry field is quite flexible.  In addition to entering the date in the format specified
by your operating system, such as MM/DD/YYYY, you can specify the date in a variety of ways.
 It will accept all of the following, in uppercase or lowercase: TODAY, YESTERDAY,
TOMORROW, NEXT TUESDAY, LAST FRIDAY, FIRST SUNDAY, SECOND WEDNESDAY,
FINAL THURSDAY, etc.
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If you need to use a calendar to pick off a date, click the calendar icon at the right edge of the
date entry field.  It will popup with the date that is currently in the date entry field highlighted, or if
the field is blank, with the current date obtained from the computer system.  Navigation is done
using the buttons located at the top of the calendar.  Single arrows move one month forward or
backward, and double arrows move one year.  Move the highlighted day either with the arrow
keys or by clicking on a day to select it and insert it into the date entry field.  Regardless of what
month and year are shown, clicking the button in the lower right corner with the letter T on it,
will take you to TODAY.  This calendar will display dates ranging from January 1, 1600 through
December 31, 3999, so it will be useful anytime in your lifetime that you need to look up dates.

Results

Local time is shown for sunrise, sunset, moonrise, moonset, dawn, and dusk.  Dawn is defined
as the beginning of civil twilight, and dusk is defined as the end of civil twilight (center of the sun
is 6 degrees below the horizon).  These correspond to the FAA definition of night, so any time
before dawn or after dusk as shown here would be considered night by the FAA.  It must be
understood that these time calculations are approximate.  For latitudes within 60 degrees of the
equator, the times are usually within 2 minutes of those predicted by more rigorous methods. 
Closer to the poles, the accuracy decreases.  In addition, other factors, such as elevation
above sea level, local terrain and obstructions, and even barometric pressure and temperature,
will affect the actual local times of rise and set.

Carbon
 

Input

Select the Carbon page to calculate the amount of carbon dioxide that is emitted for a flight or
series of flights.  Optionally, the trip distance may be entered, and the carbon dioxide per
kilometer is also calculated.

Enter the total amount of fuel burned on a flight, or series of flights.  Do not include any fuel that
was carried for reserves that was not burned, only the fuel that actually went out the tailpipe. 
Select the units for the weight of the fuel burned, either pounds or kilograms.  Optionally, enter
the trip distance, or for a series of flights, the total trip distance for all of the flights.  Select the
units for the trip distance, either nautical miles or kilometers.  Click the Compute button.

Results

The amount of carbon dioxide (CO2) emitted for the fuel burned is shown in pounds and metric
tons (tonnes).  If a trip distance was entered, the tonnes per kilometer flown will also be
displayed.
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One Click Weather

General
 

Click the Weather button to gain access to over 2,100 up to date weather graphic images, and
over 6,000 airport METAR/TAF reports.  This feature requires an open internet connection
prior to clicking any of the Retrieve buttons.  To use One Click Weather, simply select the
weather information you want to see, and click the associated Retrieve button.  A window will
open, the selected graphic image will be downloaded and displayed.  The weather window will
be maximized, filling the entire screen, so that the image will be as large and readable as
possible.  You can change the size of the window as desired.  During download, a meter
provides an indication of the progress of the download, and the download can be canceled by
clicking the Cancel button.  After the image has been displayed in its original size and shape,
you may change its display format by selecting Stretch to Fit from the dropdown box at the top
of the window.  This will stretch the image to fit the entire image exactly in the space available. 
Note that by doing this, there will likely be distortion as the aspect ratio changes, and text may
become unreadable.  When viewing is complete, close the window by either clicking the Close
button or the window close button on the title bar.

If you use firewall software, such as Norton Internet Security, when AFMatic attempts to
download the weather graphics, it may trigger the firewall software to ask you if you want to
permit this application to access the internet.  You should tell it to permit access, and to always
use this setting.  You may have to do this each time you receive an AFMatic update, depending
on the settings of the firewall software.  Even then, some of these security products will prevent
the download from taking place.  You can make the weather download work by temporarily
disabling the security software, then re-enabling it after your AFMatic session is complete.

United States
 

The vast majority of information available is for operations within the United States, with a good
bit of overlap into southern Canada and northern Mexico.

Surface Analysis and Prognosis

Select the desired graphic, and click Retrieve.  Available information includes current surface
weather, including temperature and dewpoint, and prognosis for 12, 24, 36, and 48 hours.

METAR / TAF / FA

METAR and TAF text-based reports are available for over 6,000 airports.  Enter the airport
identifier (ICAO or IATA) and click Retrieve.  Note that the airport identifiers used by NOAA may
differ from the airport identifiers contained in the worldwide airport database.  The internet
server for METAR and TAF reports is heavily loaded and may take as long as one minute to
return the data, so please be patient.  Graphical depiction of the METAR data is available. 
Select the appropriate information type or region, and click Retrieve.  Graphical depiction of the
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Terminal Area Forecast (TAF) data is available.  Select the appropriate forecast time and
information type, then click Retrieve.  Area Forecast (FA) text-based reports are available. 
Select the appropriate location, and click Retrieve.

Radar

The national radar composite, with either cloud tops or isobar lines, is available, as well as the
latest radar image from each individual radar site.  For individual sites, select the type of map
desired, then from the appropriate regional dropdown box, select the radar site you want to
see, and click Retrieve.

Satellite Images

Select the area and type of image (visible, infrared, or water vapor), and click Retrieve.

Winds / Temperatures

Select the forecast time, from current to 84 hours out, the wind or temperature information
desired, and the altitude / flight level, then click Retrieve.

Turbulence

Select the forecast time (current, 3, 6, 9, 12 hours out) and flight level, and click Retrieve.

Clouds / Icing

For cloud content, select forecast time from current to 12 hours out, altitude, and click
Retrieve.  For icing, select altitude and click Retrieve.  For freezing level, select forecast time,
from current to 12 hours out, and click Retrieve.

Airmets / Sigmets

Select the Airmet / Sigmet type, and click Retrieve.

Pilot Reports

Select the type of report (Weather / Sky, Icing, Turbulence) and the region for the map, and
click Retrieve.

International
 

International weather sources are not as easily found as they are for the United States, but
there are some graphics and reports available.
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Significant Weather

Select the forecast time and region, and click Retrieve.

METAR / TAF
METAR and TAF text-based reports are available for over 6,000 airports.  Enter the airport
identifier (ICAO or IATA) and click Retrieve.  Note that the airport identifiers used by NOAA may
differ from the airport identifiers contained in the worldwide airport database.  The internet
server for METAR and TAF reports is heavily loaded and may take as long as one minute to
return the data, so please be patient.

Satellite Images

Select the area and type of image (visible or infrared), and click Retrieve.

Canada

Information is available for surface up to flight level 240.  Select forecast time from current to 12
hours out, region, and type of information, then click Retrieve.

JetMiser

General
 

JetMiser is a feature whose purpose is to reduce the total cost of fuel for a multi-stop trip.  It
does this by using the concept of fuel tankering to optimize the amount of fuel purchased at
each stop, based on the fuel price at that stop.  More fuel will be bought at lower prices, and
less at higher prices.  Obviously, a heavier fuel load will cause more pounds of fuel to be
burned to carry the load, so you don't want to carry too much fuel, or the cost to carry it will
outweigh the benefit of buying it at a lower price.  JetMiser finds the balance point, so that the
savings are maximized.  

To use JetMiser, click on the JetMiser button at the top of the main window.  After providing the
input data in the Trip Plan, click on the Compute button to make the calculation.  JetMiser can
be slow, especially on an older computer.  This is because it is running tens, hundreds, or even
thousands of point-to-point flight planning calculations, depending on the number of legs (up to
a maximum of 50) you have specified.  Particularly time consuming are very short legs.  This is
counter-intuitive, but occurs because JetMiser tries to make the trip at the highest possible
altitude, and for a short hop it must cycle through the altitudes until it gets down to one low
enough to make the flight.  A progress bar is provided to give an indication of the approximate
percentage completion of the calculations.
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Trip Plan
 

Initial Fuel

The Initial Fuel input is for the amount of fuel that was left in the tanks after the last flight, and
prior to fueling the airplane for the first leg in the trip to be analyzed.  This amount will be
subtracted from the fuel required for the first leg in order to determine the amount of fuel that
will need to be added for the first leg.  The default amount is 0.

End Trip With Fuel

The End Trip With input is for the amount of fuel you want to have on-board at the end of the
total trip.  This will be the reserves for the final leg plus the specified amount.  You may want to
use this if you know the fuel price for the first leg of your next trip will be more than the price at
the last stop of this trip, or you may want to leave some fuel in the tanks at the end of the trip for
subsequent training or maintenance flights.  The default amount is reserves only.

The Spreadsheet

The spreadsheet with all of the input values for the calculation will initially be blank.  As you add
legs to the trip, they will appear in the spreadsheet.  Data are not edited in the spreadsheet,
only viewed.

ICAO

This is the ICAO code of the departure airport for this leg.  The destination airport for the final
leg is not shown.

Fuel Price

This is the price of fuel at the departure airport for this leg.  Price is assumed to be in US
dollars per US gallon, however, as long as the currency doesn't change from one fuel stop to
the next, any currency will work, and the final answer will be in the currency used in the
calculation.  Fuel price is a single fixed number, and does not take into consideration any
volume discount that may kick in as the fuel quantity increases.

Distance

This is the distance from the departure airport to the destination airport, in nautical miles.

MTOGW

This is the maximum takeoff gross weight that should be allowed for takeoff at the departure
airport for this leg.  The default value is the structural limited takeoff weight of the airplane.
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MLGW

This is the maximum landing gross weight that should be allowed for landing at the destination
airport for this leg.  The default value is the structural limited landing weight of the airplane.

Passengers

This is the number of passengers to be carried on this leg of the trip.

Mach

This is the Mach number to be used during level cruising flight on this leg of the trip.  If an
altitude must be flown that is low enough that the selected Mach number is greater than MMO /
VMO, then the calculation will be done at MMO / VMO.  So, if you have a really short leg, like
KHPN to KTEB for example, it is okay to specify a Mach number of .80, knowing that the leg will
be flown at or below 5,000 feet, which has a very low VMO.

Wind

This is the average wind component for this leg of the trip, in knots.

Delta ISA

This is the temperature, expressed as a delta from the standard day temperature (ISA), in
degrees Celcius.

Reserves

This is the specified reserves for this leg of the trip.  Three types of reserves are available: fixed
reserves, NBAA IFR reserves, and reserves based on the distance to the alternate airport, from
the chart found in the Operating Manual (or Cruise Control Manual).  For fixed reserves, you will
see the amount of fuel, in pounds, that will be held in reserve.  For NBAA IFR reserves, you will
see the note "NBAA".  And for Ops Manual reserves, you will see the distance from the
destination airport to the alternate airport that has been specified.

Add Button

Click this button to add a leg to the end of the trip plan.  The JetMiser Flight Leg input dialog will
be activated, which allows you to enter all of the appropriate information for each leg of the trip.

Edit Button



AFMatic38

© Copyright 1998-2016 Tybee Jet Corporation

To edit an existing flight leg, select the leg by clicking on it, then click the Edit button to activte
the JetMiser Flight Leg input dialog and edit the information.  Alternately, you may double click
the leg.

Delete Button

To delete an existing flight leg, select the leg by clicking on it, then click the Delete button to
remove the leg from the trip plan.  Note that if there are any flight legs after the one to be
deleted, you will need to edit the legs surrounding the deleted one to update the departure and
destination airport ICAO codes and distances.

Move Up Button

To move a leg up in the trip plan, select the leg by clicking on it, then click the Move Up button,
as many times as necessary to move it to the new location required.  Note that you will need to
edit the legs surrounding the new and old positions, to update the ICAO codes and distances.

Move Down Button

To move a leg down in the trip plan, select the leg by clicking on it, then click the Move Down
button, as many times as necessary to move it to the new location required.  Note that you will
need to edit the legs surrounding the new and old positions, to update the ICAO codes and
distances.

Clear Button

To completely clear the trip plan and start over, click the Clear button.  This will not delete any
trip plans that you have saved to disk, only what is visible in the trip plan.

Save Button

Setting up a trip with many stops can be a time consuming task.  If you fly the same trip many
times, you don't want to have to enter all the data from scratch every time.  When you have the
trip set up, click the Save button and save it all to disk.  Then you can retrieve it at a later time
and continue working with it.  In addition to saving the trip plan manually, whenever you click
Compute, the trip will be automatically saved in a file named LastCalc.JM, which you can
retrieve at any time.

Retrieve Button

To retrieve a trip plan that was previously saved using the Save button, or the last JetMiser
calculation that was done, click the Retrieve button and select the trip plan you want to retrieve.
 The default will be LastCalc.JM, which is the last JetMiser calculation that was performed.
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Flight Leg Editor
 

General

The JetMiser Flight Leg dialog is used to input or edit the information for each flight leg in the
trip.

Departure ICAO Code

This is the ICAO code for the departure airport.  Enter the airport identifier and click Retrieve, or
press Enter.  You must retrieve the airport to make it possible to compute the great circle
distance for the leg, and also to provide the airport elevation for the calculations.  You may also
search for an airport using the Search button.

Destination ICAO Code

This is the ICAO code for the destination airport.  Enter the airport identifier and click Retrieve,
or press Enter.  You must retrieve the airport to make it possible to compute the great circle
distance for the leg, and also to provide the airport elevation for the calculations.  You may also
search for an airport using the Search button.

Flight Distance

You may enter the distance for this flight leg if you know it (e.g. from a flight plan), or you may
have AFMatic calculate it for you based on the great circle distance.  To calculate, click the
Calc button.  The Distance Calculator allows you to add a percentage to the great circle
distance, and/or add a fixed distance.  So, to approximate an actual flight plan distance, you
might add 2% to estimate the additional distance due to flying airways instead of direct, and 10
miles to estimate the added distance to shoot an instrument approach.  After the number is
calculated, click the appropriate Insert button to insert it into the Flight Distance input field.

Max Takeoff Weight

This is the maximum takeoff weight to be allowed in the JetMiser calculations for this departure
airport.  The default is the structural limited takeoff weight.  If you have performed a takeoff
calculation for the departure airport, you may insert the takeoff weight from that calculation by
clicking the Tkf Calc button.  If no takeoff calculations have been performed during this AFMatic
session, the button will be disabled.

Max Landing Weight

This is the maximum landing weight to be allowed in the JetMiser calculations for this
destination airport.  The default is the structural limited landing weight.  If you have performed a
landing calculation for the destination airport, you may insert the landing weight from that
calculation by clicking the Ldg Calc button.  If no landing calculations have been performed
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during this AFMatic session, the button will be disabled.

Departure Fuel Price

This is the price of fuel at the departure airport for this leg.  Price is assumed to be in US
dollars per US gallon, however, as long as the currency doesn't change from one fuel stop to
the next, any currency will work, and the final answer will be in the currency used in the
calculation.  Fuel price is a single fixed number, and does not take into consideration any
volume discount that may kick in as the fuel quantity increases.

Passengers

This is the number of passengers to be carried on this leg of the trip.  The zero fuel gross
weight is calculated by adding the BOW and the number of passengers times the default
passenger weight plus the default baggage weight per passenger, i.e. ZFGW = BOW + PASS
* (PASSWT + BAGWT).

Cruise Mach Number

This is the Mach number to be used during level cruising flight on this leg of the trip.  Select the
desired speed from the list.  If an altitude must be flown that is low enough that the selected
Mach number is greater than MMO / VMO, then the calculation will be done at MMO / VMO.  So,
if you have a really short leg, like KHPN to KTEB for example, it is okay to specify a Mach
number of .80, knowing that the leg will be flown at or below 5,000 feet with a very low VMO.

Delta ISA

This is the temperature, expressed as a delta from the standard day temperature (ISA), in
degrees Celcius.  Select the desired temperature from the list.

Wind Component

This is the average wind component for this leg of the trip, in knots.  Select headwind or
tailwind.

Reserves

Select the reserve type for this leg of the trip, then enter the appropriate value.  Three types of
reserves are available: fixed reserves, NBAA IFR reserves, and reserves based on the
distance to the alternate airport, from the chart found in the Operating Manual (or Cruise
Control Manual).  For fixed reserves, you will enter the amount of fuel, in pounds, that will be
held in reserve.  And for Ops Manual reserves, you will enter the distance from the destination
airport to the alternate airport that has been specified, in nautical miles.
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Save & Add Button

When adding legs to the trip plan, clicking this button is equivalent to clicking the Save Only
button, then clicking the Add button on the Trip Plan.  It will save the current leg, clear the
JetMiser Flight Leg dialog, place the Destination ICAO Code from the just-saved leg in the
Departure ICAO Code field, and leave you ready to enter the rest of the information for the next
leg.  If you are editing an existing flight leg, instead of adding a new one, this button will be
labeled Save & Next, and will work in a similar fashion, saving the current leg and bringing in
the next one from the trip plan, ready to be edited.

Save Only Button

This button saves the current leg and returns you to the trip plan.

Clear Button

This button clears the JetMiser Flight Leg dialog, leaving you ready to input information for the
current leg.

Cancel Button

This button cancels the Add or Edit operation, and takes you back to the trip plan with no
changes being made.

Results
 

General

The results of the JetMiser calculation are shown on the Results page.  Results may be printed
by selecting the Print item from the File menu, or pressing CTRL-P.  Results may be saved to
a text file by selecting the Save item from the File menu, or pressing CTRL-S.

ICAO Code

This is the ICAO code of the departure airport for this leg.

Fuel Price

This is the price of fuel at the departure airport for this leg.

Minimum Fuel Load

This is the minimum amount of fuel that must be in the tanks prior to engine start in order to
complete this flight leg with the required reserves remaining, under the specified flight
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parameters.

A word of caution:  The cruise calculations upon which JetMiser is based have been tested
against calculations made by Gulfstream engineers.  However, regardless of the confidence
we have in the accuracy of these calculations, you should never load less fuel on-board
for a flight than your computerized flight plan calls for.

Minimum Fuel Add

This is the amount of fuel that must be added to the tanks in order to have the Minimum Fuel
Load on-board at engine start.  For the first leg, this will be the Minimum Fuel Load minus any
fuel specified as Initial Fuel.  For other legs, it will be the Minimum Fuel Load minus the reserve
fuel from the previous leg.

Minimum Cost

This is the cost of the fuel that must be added in order to meet the Minimum Fuel Load, based
on the Fuel Price.

Optimum Fuel Load

This is the optimum amount of fuel to have in the tanks prior to engine start, in order to
minimize the total fuel cost for the entire trip.  The amount of fuel that is over and above the
Minimum Fuel Load is the fuel that is being tankered for use on a subsequent flight leg.

Optimum Fuel Add

This is the amount of fuel that must be added to the tanks in order to have the Optimum Fuel
Load on-board at engine start.  For the first leg, this will be the Optimum Fuel Load minus any
fuel specified as Initial Fuel.  For other legs, it will depend on the amount of fuel remaining in the
tanks at the end of the previous leg, including reserve fuel and tankered fuel.  Sometimes you
will find that it specifies that a very small amount of fuel must be added, a few hundred pounds
or less.  This is because the methodology finds the absolute minimum cost, even if it only
saves a few dollars over tankering the total amount.  In these cases you will probably want to
add that fuel to the previous leg.

Optimum Cost

This is the cost of the fuel that must be added in order to meet the Optimum Fuel Load, based
on the Fuel Price.

Minimum Fuel Total Cost
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This is the sum of the values in the Minimum Cost column in the spreadsheet, and represents
the total cost of fuel for the trip if you load only the minimum amount of fuel at each stop.

Optimum Fuel Total Cost

This is the sum of the values in the Optimum Cost column in the spreadsheet, and represents
the total cost of fuel for the trip if you load the recommended optimum amount of fuel at each
stop.

Savings

This is the difference in the Optimum Fuel Total Cost and Minimum Fuel Total Cost, and is the
amount you would save by following the recommended optimum fuel loading.

Fuel Units

You may select the units of measurement for the Minimum Fuel Load, Minimum Fuel Add,
Optimum Fuel Load, and Optimum Fuel Add columns by clicking on the desired units.  The
default is pounds.

Airport Search
 

General

The airport search function may be utilized by clicking the Search button in any Airport Identifier
box throughout the program.  These are found on the Takeoff and Landing Airport pages, Misc.
Pavement page, Tools Wind and Sunrise/Sunset pages, and Database / Edit Obstacle Data
and Database / Edit SID Data menu items.  In each case, once you have found the desired
airport, you may insert that airport identifier in the original airport identifier input field, and
retrieve the airport data from the database.

Airport Search List

After clicking the Search button, a window will pop up with a scrollable list of all of the airports in
the worldwide airport database.  Depending on the speed of your computer and hard disk, it
may take a few seconds for the Airport Search dialog to appear, since all of the airports in the
database must be retrieved and loaded into the list.  There are columns for ICAO code, IATA
code, airport name, city, state, country, elevation, and length of the longest runway.  You may
sort the airport list by any of these columns simply by clicking on the column header.  A second
click on the same column header will cause the list to be sorted in reverse alphabetical order. 
You may either scroll the list using the scrollbar on the right, or you may search by typing in the
Search input field.  As you type in the Search field, the cursor in the airport list will move to the
first airport in the current sort column that begins with the text you have typed in the Search
field.  You may format the display in any of three ways.  The first is simply a spreadsheet-like
list of all of the airports, which is termed "All Airports" in the format selector.  Next, the airports
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can be grouped by country with the "By Country" format.  Finally, the airports can be grouped
by country and state with the "By Country and State" format.  Only the United States currently
has state specified in the database, so the last format will only be useful for finding airports in
the USA.  When you have found the desired airport, you can insert it in the airport identifier input
field where you began the search by clicking the Insert button, or pressing Enter.  You may also
view the airport data by clicking the View button, or you may find alternate airports to use with
this airport by clicking the Find Alternates button.  You may also exit the airport search dialog
without selecting anything by clicking the Cancel button.

Find Alternate Airports

If you clicked the Find Alternates button in the Airport Search dialog, you will first be presented
with a dialog which allows you to specify the search criteria to be used in determining which
airports are suitable alternates.  Enter the maximum distance between the destination airport
and the alternate, in nautical miles.  Then enter the minimum acceptable runway length, in feet.
 Click the Find Alternates button to display the list of alternates, or click Cancel to return to the
Airport Search dialog.  The defaults for the distance and runway length input fields may be set
by selecting Options / Preferences, and clicking the Misc. tab.

Alternate Airport List

A list of all airports meeting the specified search criteria is displayed, in a similar format to the
Airport Search list.  However, two columns have been added, one for the distance from the
destination airport, and the other for the bearing from the destination airport.  The list is initially
sorted on the distance column, so that airports closest to the destination are at the top of the
list.  You may sort this list by any of the columns, including bearing, just as with the Airport
Search list.  An interesting use for sorting by bearing might be if severe weather existed to the
west of the destination airport, and you wanted to find suitable alternates to the east.  Simply
click on the bearing column header, and the airports will be sorted around the compass from 1
to 360 degrees, making it easy to pick out which potential alternates lie to the east.  You may
click on an airport to select it, and then click on the Insert button to insert it in the airport
identifier input field where you began the search, or you may click Cancel to return to the Airport
Search dialog.

File Menu

Save
 

Save the results of calculations and airport / runway data to a file.  The default is to save all
calculations in one file, and the file will be placed in the directory where the AFMatic executable
is located, in a file named "Output.txt".  You may change the file name and location either by
typing in the file name field or by clicking the Search button and searching for the new location.
 You may also elect to save all airport information, or any single item, which you may select. 
These data will be saved in a plain text format that can later be printed or emailed to another
location.  The information stored with this function is identical to what is printed with the print
function.  Save can be invoked by pressing Ctrl-S.
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Print
 

Print the results of calculations and airport / runway data to a printer.  The default is to print all
calculations.  You may also elect to print all airport information, or any single item, which you
may select.  These data will be printed in a plain text format, using the default fixed pitch printer
font.  You may change the font size from the default 12 point size.  This feature was primarily
added in order to facilitate getting the entire printout on a single page for some printers that had
preset margins that are narrower than normal.  You may also invoke the printer setup dialog by
clicking the Setup button at the bottom of this dialog.  When ready to print, click the Print Now
button.  The information printed with this function is identical to what is stored with the save
function.  Print can be invoked by pressing Ctrl-P.

Exit
 

Terminate AFMatic execution.  This produces the same result as clicking the close box in the
upper right corner of the program window, pressing Alt-X, or pressing Alt-F4.

Database Menu

New Aircraft

General
 

To add a new aircraft (by serial number) to the user database, select the New Aircraft function
from the Database menu.  When you have finished entering the information needed to define
your aircraft, clicking the Save button will save the aircraft definition to disk, where it will be
available for future selection in the Select Aircraft function.  Clicking the OK button will dismiss
the dialog.  Be sure to save prior to clicking OK.  Leaving the dialog without saving will throw
away your inputs.

Identification
 

In the registration field, you specify the aircraft's registration (tail) number, also known as N-
number in the United States.  This is a simple text field and no validity checking is done, so this
entry will be stored just the way you enter it.  This will become the identifier for this aircraft,
which you will use to select it from the Select Aircraft function on the Options menu.  Next is
the Aircraft Code field, in which you must enter the aircraft code for this aircraft.  You will find
the aircraft code located on the card that is enclosed with the AFMatic CD-ROM.  This 16 digit
code must be correctly entered in order to properly identify your aircraft.  Note: The
characters contained in the Aircraft Code include the numbers 0-9 and letters A-F only.
 There are no letters I,O, or Z.  When you type the last character of the code, it will be
decoded and the aircraft serial number, type, and certification basis will be displayed.  If these
do not match your aircraft, check to see that you have entered the aircraft code correctly.  If the
aircraft code is correct and the decoded values are not, contact Tybee Jet for a corrected
aircraft code.  Lastly, if this is the aircraft that you want to be loaded automatically when the
program starts up, check the Make Default box.  
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Mods
 

If there are modifications available for the aircraft type you selected on the identification page,
they will be listed on the modifications page.  Click on the box next to the description for the
modification that you want to associate with your airplane, to put a check mark in the box. 
Whenever the flight manual data are loaded for your aircraft, data for any modifications that are
checked will be included in the calculations.

Weights
 

AC120-27E Compliance

AFMatic has the ability to compute weight and balance in compliance with the FAA Advisory
Circular 120-27E, "Aircraft Weight and Balance Control".  Check this box to default to using
AC120-27E compliant calculations.  The Passenger Weights selection allows you to select the
weights to use in the calculations.  The first weights listed are from Table 2-2, "Average
Passenger Weights for Operators With a No-Carry-On Bag Program".  Next are listed weights
for use of Segmented Weights, as described in Section 4 of AC120-27E, for % of male
passengers ranging from 90 down to 50%.  Finally, a selection to allow choosing between
male, female, or child passengers, based on the summer weights from Table 2-2.

Default Weights

Default weights for passengers, baggage for each passenger, and fuel consumption for start/
taxi/takeoff, may be set here, specified in units of pounds or kilograms.  These defaults will be
used on the Loading page of the Weight & Balance calculation.

Configuration

It is possible to set each aircraft up with as many as 5 different configurations.  This will
facilitate the changing of interior configurations, such as removing a divan and replacing with a
pair of executive seats, or major changes like switching between an executive interior, air
ambulance, and cargo.  To step through the configurations, click the Next button.  To clear a
configuration, click the clear button.  There must be at least one defined configuration for the
aircraft.  Each configuration can be given a descriptive name, and each configuration must
have a name specified.  Click the Default box to select this configuration as the default.

Basic Operating

The basic operating weight, in units of pounds or kilograms, and the center of gravity of the
aircraft at the basic operating weight, in inches aft of the datum, are specified.  Basic operating
weight, for purposes of this software, is defined to include the weight of the basic airplane,
crew, crew baggage, and all consumables.  In other words, everything except the passengers,
passenger baggage, cargo, and fuel.  Note that the horizontal arm must be entered as inches
aft of the datum.  An error message will be displayed if the arm is specified as percent mean
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aerodynamic chord (% MAC).

Floorplan

If you have a floorplan available, check the Use Floorplan box and select the floorplan bitmap
image in the drop-down box next to it.  The floorplan files (*.bmp and *.fpd) must be located in
the same directory as the  AFMatic program files.  These floorplan files will be customized by
Tybee Jet and provided to you.  They require a floorplan graphic provided to Tybee Jet by the
Gulfstream Publications Department, and the page from your weight and balance report that
contains the seat arm information, provided to Tybee Jet by you.  If a floorplan has not yet been
provided to you, please contact Tybee Jet and arrange for that.  In the meantime, leave the Use
Floorplan box unchecked.

Passenger Seat Locations

Enter the locations of the passenger seats in the airplane, in inches aft of the datum.  The
seats do not need to be in order from front to back or back to front.  They will be sorted into
order during the calculation.  Number them in any order that suits you.  The maximum number
of seats that you can enter is determined by the maximum number of passengers allowed in
the AFM limitations.

Additional Storage Locations

You may specify up to five additional storage locations within the airplane.  You do not need to
include the baggage compartment, since the baggage is specified separately during
calculation.  Give each location a name of up to 12 characters, such as "Fwd Closet", specify
the arm of the center of the storage area, and the maximum weight that can be stored in the
area, in the same units as used for basic operating weight.  These storage areas will appear on
the weight and balance loading page, where you will enter the weight to be stored in each one.

Miscellaneous
 

The default flap setting for takeoff and optimize box setting, which appear on the Takeoff
Configuration page are specified.  The default method for calculation of SID required climb
gradient clearance is selected from the list of methods available for this aircraft type.  For FAR
135 operators, the Operational Information Supplements for SID Climb specify that it is
necessary to clear 70 feet height at the Departure End of the Runway.  You may check the box
to assure that this height is achieved when using the SID Climb methods.  Also, the default
setting of the FLEX takeoff box which appears on the Takeoff Atmospherics page is set here.

Edit Aircraft

General
 

The Edit Aircraft function looks and works like the New Aircraft function, with the addition of a
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Retrieve button, and a Delete button.  To add a new aircraft, you must use the New Aircraft
function, described above.  You may edit an aircraft by selecting the registration from the drop-
down list and clicking the Retrieve button.  This will retrieve the aircraft data that you previously
entered.  You may then make changes as desired and save it to disk by pressing the Save
button.  You may also delete the aircraft from the database by clicking on the Delete button. 
Clicking the OK button will dismiss the dialog, but once again, be sure you have saved your
changes before leaving the dialog.  

Identification
 

In the registration field, you specify the aircraft's registration (tail) number, also known as N-
number in the United States.  This is a simple text field and no validity checking is done, so this
entry will be stored just the way you enter it.  This will become the identifier for this aircraft,
which you will use to select it from the Select Aircraft function on the Options menu.  Next is
the Aircraft Code field, in which you must enter the aircraft code for this aircraft.  You will find
the aircraft code located on the card that is enclosed with the AFMatic CD-ROM.  This 16 digit
code must be correctly entered in order to properly identify your aircraft.  Note: The
characters contained in the Aircraft Code include the numbers 0-9 and letters A-F only.
 There are no letters I,O, or Z.  When you type the last character of the code, it will be
decoded and the aircraft serial number, type, and certification basis will be displayed.  If these
do not match your aircraft, check to see that you have entered the aircraft code correctly.  If the
aircraft code is correct and the decoded values are not, contact Tybee Jet for a corrected
aircraft code.  Lastly, if this is the aircraft that you want to be loaded automatically when the
program starts up, check the Make Default box.  

Mods
 

If there are modifications available for the aircraft type you selected on the identification page,
they will be listed on the modifications page.  Click on the box next to the description for the
modification that you want to associate with your airplane, to put a check mark in the box. 
Whenever the flight manual data are loaded for your aircraft, data for any modifications that are
checked will be included in the calculations.

Weights
 

AC120-27E Compliance

AFMatic has the ability to compute weight and balance in compliance with the FAA Advisory
Circular 120-27E, "Aircraft Weight and Balance Control".  Check this box to default to using
AC120-27E compliant calculations.  The Passenger Weights selection allows you to select the
weights to use in the calculations.  The first weights listed are from Table 2-2, "Average
Passenger Weights for Operators With a No-Carry-On Bag Program".  Next are listed weights
for use of Segmented Weights, as described in Section 4 of AC120-27E, for % of male
passengers ranging from 90 down to 50%.  Finally, a selection to allow choosing between
male, female, or child passengers, based on the summer weights from Table 2-2.
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Default Weights

Default weights for passengers, baggage for each passenger, and fuel consumption for start/
taxi/takeoff, may be set here, specified in units of pounds or kilograms.  These defaults will be
used on the Loading page of the Weight & Balance calculation.

Configuration

It is possible to set each aircraft up with as many as 5 different configurations.  This will
facilitate the changing of interior configurations, such as removing a divan and replacing with a
pair of executive seats, or major changes like switching between an executive interior, air
ambulance, and cargo.  To step through the configurations, click the Next button.  To clear a
configuration, click the clear button.  There must be at least one defined configuration for the
aircraft.  Each configuration can be given a descriptive name, and each configuration must
have a name specified.  Click the Default box to select this configuration as the default.

Basic Operating

The basic operating weight, in units of pounds or kilograms, and the center of gravity of the
aircraft at the basic operating weight, in inches aft of the datum, are specified.  Basic operating
weight, for purposes of this software, is defined to include the weight of the basic airplane,
crew, crew baggage, and all consumables.  In other words, everything except the passengers,
passenger baggage, cargo, and fuel.  Note that the horizontal arm must be entered as inches
aft of the datum.  An error message will be displayed if the arm is specified as percent mean
aerodynamic chord (% MAC).

Floorplan

If you have a floorplan available, check the Use Floorplan box and select the floorplan bitmap
image in the drop-down box next to it.  The floorplan files (*.bmp and *.fpd) must be located in
the same directory as the  AFMatic program files.  These floorplan files will be customized by
Tybee Jet and provided to you.  They require a floorplan graphic provided to Tybee Jet by the
Gulfstream Publications Department, and the page from your weight and balance report that
contains the seat arm information, provided to Tybee Jet by you.  If a floorplan has not yet been
provided to you, please contact Tybee Jet and arrange for that.  In the meantime, leave the Use
Floorplan box unchecked.

Passenger Seat Locations

Enter the locations of the passenger seats in the airplane, in inches aft of the datum.  The
seats do not need to be in order from front to back or back to front.  They will be sorted into
order during the calculation.  Number them in any order that suits you.  The maximum number
of seats that you can enter is determined by the maximum number of passengers allowed in
the AFM limitations.
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Additional Storage Locations

You may specify up to five additional storage locations within the airplane.  You do not need to
include the baggage compartment, since the baggage is specified separately during
calculation.  Give each location a name of up to 12 characters, such as "Fwd Closet", specify
the arm of the center of the storage area, and the maximum weight that can be stored in the
area, in the same units as used for basic operating weight.  These storage areas will appear on
the weight and balance loading page, where you will enter the weight to be stored in each one.

Miscellaneous
 

The default flap setting for takeoff and optimize box setting, which appear on the Takeoff
Configuration page are specified.  The default method for calculation of SID required climb
gradient clearance is selected from the list of methods available for this aircraft type.  For FAR
135 operators, the Operational Information Supplements for SID Climb specify that it is
necessary to clear 70 feet height at the Departure End of the Runway.  You may check the box
to assure that this height is achieved when using the SID Climb methods.  Also, the default
setting of the FLEX takeoff box which appears on the Takeoff Atmospherics page is set here.

Edit Airport

General
 

You may add airport and runway data to the database.  The airport database is stored in two
separate parts on disk.  The first part is the worldwide airport database, which is read-only. 
This database includes all airports in the world with hard surfaced runways of at least 3,000
feet length.  The other part of the airport database is the user airport database, which stores
airport, runway, obstacle, and SID gradient data that are entered by the user.  In the Airport /
Runway Editor, you may add airport and runway data to the user airport database, or edit data
that you have already added.

There are several restrictions in the way data are stored that you should be aware of.  First, if
an airport exists in the worldwide airport database, you may not simply add runways to it.  You
must create a new airport and put the new runways in it.  In other words, runways cannot be
split between the two databases.  The second restriction is that you may not create a new
airport that has the same ICAO or IATA identifier as an airport in the worldwide airport
database.  You may, however, retrieve an airport from the worldwide airport database and save
it to the user database, by changing the ICAO identifier.  For example, you could copy KSAV,
Savannah International, by retrieving KSAV, changing the ICAO identifier to _SAV, for example,
and then saving that.

Please note that you must save your changes and additions by clicking on the Save Airport
button for airport data, or Save Runway button for runway data, before leaving the Airport /
Runway Editor.  These saves are not performed automatically.



Database Menu 51

© Copyright 1998-2016 Tybee Jet Corporation

Airport Section
 

General

The airport section contains entry fields for data relating to the airport as a whole.  You may
retrieve an existing airport to edit, or you may enter a new airport from scratch.  After making
the changes, you must save the data to the database by clicking on the Save Airport button. 
When you click on the Save Airport button to save airport data, you are saving only the items in
the airport section.  You must save runway data separately by clicking on the Save Runway
button.  Be sure that you have saved the airport data before dismissing the dialog.  This is not
automatically done for you.

You may clear the fields in both the airport and runway sections by clicking on the Clear Airport
button.  This resets all entry fields to their default (blank) values.

You may delete an airport that you have entered by specifying its ICAO identifier and clicking on
the Delete Airport button.  You may not delete an airport that is stored in the worldwide airport
database.

Airport

The Airport box contains 3 entry fields, for ICAO identifier, IATA identifier, and field elevation. 
When adding a new airport, use these fields to enter the appropriate values.  If you want to edit
an airport that already exists in the database, enter either the ICAO or IATA identifier, then
press Enter or click on the Retrieve button next to the identifier that you entered, and the airport
data will be retrieved from the database and displayed.

Airport Location

In the Airport Location box, enter the airport name, city, state or province, and country.  State or
province is an optional field, and consists of a two-letter abbreviation.  The country field is a 3-
letter abbreviation.

Runway Section
 

General

Runway data are edited and stored separately from airport data.  You must have an airport
specified prior to editing runway data.  You must save runway data separately from airport data.
 So, if you add a new airport and save the airport, you would then add a runway and save it,
then clear the runway by pressing the Clear Runway button, add data for another runway and
save it, etc.  Like airport data, you must save runway data by pressing Save Runway prior to
dismissing the Airport Editor dialog by pressing the OK button.
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Clicking on the Clear Runway button will clear the runway data and reset all of the input fields to
their default (blank) values.  This will have no effect on the airport data in the airport section.

You may delete a runway that you have entered by clicking on the Delete Runway button.  You
may not delete a runway from the worldwide airport database.

Runway

If you are editing an existing runway, select it from the drop-down list by clicking on it or using
the arrow keys to highlight your choice, and then press Enter or click on the Retrieve button.  If
you are adding a runway, select Add and press Enter.  If editing an existing runway, be sure to
retrieve the runway data before you begin changing values in the other entry fields, because
when you retrieve the data from the database, it will be put in the entry fields, and overwrite any
changes that you already made.

Miscellaneous

Here you enter the runway identifier for a new runway, runway magnetic bearing (or true
bearing for far north airports that use true instead of magnetic), slope in percent, and elevation
of the brake release end of the runway in feet.  The runway identifier may be any 3 characters. 
It will not be forced to fit the standard runway identifier convention.  To calculate a slope from
runway length and elevation at both ends, press the Calc button located next to the slope entry
field.

Runway Slope Calculator

You may calculate the runway slope using the Runway Slope Calculator, which is activated by
pressing the Calc button located by the slope entry field on the Airport / Runway Editor screen.
 Enter the runway length, in feet, followed by the elevation of the brake release end of this
runway, and finally the elevation of the liftoff end of this runway (brake release end of the
opposite runway), also in feet.  Press Enter or click the Compute button, and the slope will be
computed.  To insert the slope into the entry field in the Airport / Runway Editor, press Enter or
click the Insert button.  To cancel without inserting, press Escape or click the Cancel button.  If
you insert the results, the length and brake release elevation will also be inserted into the
appropriate entry fields.

Lengths

Here you enter the runway length, stopway (if any), clearway (if any), and displaced threshold
for landing (if any), all in feet.

Runway Surface
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Select hard or soft runway surface.

Edit Obstacle
 

General

To enter obstacle data for a runway, you must first retrieve an existing airport and runway from
the database, in order to define which runway the obstacle data will be associated with.  Once
you have retrieved the airport and runway, you may enter the obstacle location data for up to 20
obstacles per runway, as well as optional length, clearway, stopway, and slope data.  Then
click on the Save button to save the obstacle data in the database. Clicking on the OK button
dismisses the obstacle editor dialog.  Be sure you have saved your data before exiting, since
this will not be done for you automatically.

Airport Identifier

Enter the 4-letter ICAO identifier, or the 3-letter IATA identifier.  Click on the ICAO or IATA button
to select which identifier has been specified.  Press Enter or click on the Retrieve button to
retrieve the airport from the database.  You may view the airport information by clicking on the
View button, either before or after pressing the Retrieve button.  When the airport has been
retrieved, the Airport / Runway Info box will contain the airport name and city, state, and
country.  The text on the Retrieve button will change color from red to green when an airport
has been read into memory.  Click the Search button to search for an airport in the database by
name, city, or location.

Runway

When the airport data are retrieved from the database, the runway identifier drop-down list is
filled with a list of the runways that are available for this airport in the database.  Select the
desired runway from this list by clicking on it or using the arrow keys to highlight your choice,
and then press Enter or click on the Retrieve button to retrieve the runway data from the
database, or the View button to retrieve the data and view it.  When the runway has been
retrieved, the Airport / Runway Info box will contain the runway identifier, length, and end
elevation.  The text on the Retrieve button will change color from red to green when a runway
has been read into memory.

Runway (Optional)

Most users can ignore the input fields in this box.  Its purpose is to allow a flight operations
department to have total control over the data that are used in the calculation of obstacle
clearance takeoffs.  This would be of primary interest to a FAR 135 or 121 operator.  By filling in
these fields and checking the Override Apt DB Runway Info box, these values will be used in
place of the values from the worldwide airport database in takeoff calculations.  It is not
recommended that you do this unless you have a specific need to do so, since the worldwide
airport database will be updated every 28 days, and these data will change only when you
change them.
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Units and Measurement Basis

By default, the distance to the obstacle is measured from the brake release end of the runway
(BR end), and the units of measurement for all measurements are feet.  You may enter
distances referenced to the liftoff end of the runway (LO end) by selecting LO End in the Dist
From box.  Obstacle height is always measured AGL above the liftoff end of the runway. 
Distances may be entered in units of feet, meters, or nautical miles, by selecting the
appropriate units in the Dist Units box.  Units for height above runway and offset from runway
centerline may be selected in the Ht Units box, and are limited to feet and meters.  Please note
that these units and reference point will be applied to all obstacles that are entered in the table
below.  When the Save button is clicked, the obstacle positions will be converted to be
referenced to the brake release end of the runway, and the units will be converted to feet.  The
converted obstacles will be stored in the database, and the display will be updated to reflect the
conversion.  Whenever the obstacles are recalled from the database, they will be shown in the
default units.

Obstacles

This is where the obstacle distance, height, and offset from extended runway centerline are
entered.  Up to 20 obstacles may be input for each runway.  By default, the distance is
measured from the brake release (approach) end of the runway, in feet.  The reference runway
end and units of measurement can be changed with the Dist From and Dist Units boxes
respectively.  Height is the height above the liftoff (departure) end of the runway, in units
selected in the Ht Units box.  This may seem an odd combination, but has been selected to
maintain consistency with the Jeppesen OpsData format.  The offset is entered as a positive
number if the obstacle is to the right of centerline, and a negative if it is to the left, in the units
selected in the Ht Units box.  Offset is used to determine if an obstacle is within the selected
calculation envelope (FAA or ICAO) at the time of calculation.  Be sure to enter obstacles
beginning on the top line of the table and proceeding down, since the first line having a zero for
the distance value denotes the end of the obstacle table.

Use of Obstruction Data Sheets

Care must be taken when entering obstacle data, particularly if your source is an Obstruction
Data Sheet (ODS), which is the tabulated version of the Airport Obstruction Chart.  The ODS is
built on the concept of the obstacles being obstructions to landing, rather than takeoff, so you
must reverse the direction.  For example, obstacles that are listed for runway 08 are actually
takeoff obstacles for 26.  Once you have the runway number straight, then you must pick the
right numbers out of the tables.  The obstacle height will be the value in the HAR (Height above
runway) column.  This will give you the desired height above the liftoff end of the runway. 
Distance is a little harder to obtain.  You must first view the desired runway and make note of
the TORA distance.  The distance you will enter in the obstacle table is the value in the DEND
(Distance from end) column in the ODS added to the TORA distance you wrote down from
viewing the runway data.  This will make the proper correction so that the distance is measured
from the brake release end of the runway.  Lastly, the offset is from the DCLN (Distance from
centerline) column in the ODS.  Since we're going the other way, enter right offset as a
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negative, and left as positive.  You will notice in many cases that there are obstacles with
negative DEND values.  These are for items that are located on the airport before you get to the
liftoff end of the runway.  AFMatic doesn't compute obstacle clearance for these, so you may
as well not include them in the database, since they'll never be used.

Import Obstacle
 

You may read obstacle data files provided by Jeppesen OpsData, and store the data in the
user airport data file, for later use.  This function is activated by selecting Import Obstacle Data
from the Database menu.  Enter the name of the file in the File box.  You may search for the file
by clicking on the Search button, which will open the Windows Open dialog.  If you type in the
file name, you may include the full path.  If the file is located in the same directory with the
AFMatic executable program file, you may leave the path off and just enter the file name. 
Check the Override Apt DB Info box if you wish to have the runway length, clearway, stopway,
and slope information from the OpsData obstacle file replace the information from the
worldwide airport database in your calculations.  This is not recommended unless you
specifically need to do so, since the worldwide airport database is updated more frequently
than the OpsData information, and changes to the runway may be missed if you have
overridden Apt DB info.  Press the Import button to perform the file import, or press Cancel to
abort the operation.

To obtain Jeppesen OpsData obstacle data, contact Jeppesen.

Edit SID
 

General

To enter SID required climb gradient data for a runway, you must first retrieve an existing
airport and runway from the database, in order to define which runway the SID data will be
associated with.  Once you have retrieved the airport and runway, you may enter a name for
the SID, a transition (if any), and the required minimum gradient and altitude up to which that
gradient must be maintained.  Then click on the Save button to save the SID data in the
database.  After a SID has been stored, you may retrieve it for editing or deletion by selecting it
from the drop-down list in the SID box, and clicking on Retrieve.  Clicking on the OK button
dismisses the SID editor dialog.  Be sure you have saved your data before exiting, since this
will not be done for you automatically.

SID climb gradient requirements developed in accordance with the TERPS procedures include
a margin of 48 feet per nautical mile, which is equivalent to a climb gradient of 0.8%.  Obstacle
clearance data in the Airplane Flight Manual also include a margin of 0.8%, the difference
between gross and net flight path.  The TERPS (FAA Handbook 8260.3/AFJM 11-226, United
States Standard for Terminal Instrument Procedures) require a minimum gross climb gradient
for instrument departures which clears obstacles by 48 feet per nautical mile (0.8%).  Thus, the
use of AFM obstacle clearance data in combination with a published SID required climb
gradient results in a margin of 96 feet per nautical mile, which is twice the required margin.  It is
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left to the operator to make, and take responsibility for, the decision of whether to reduce the
SID required climb gradient by 48 feet per nautical mile in order to eliminate the double margin.
 If it is desired by the operator to do this, enter the reduced gradient in the Gradient field,
otherwise, enter the required climb gradient as specified on the SID chart.  AFMatic makes its
computations based on the gradient that is entered and stored here, and does not make any
adjustments internally to either the gradient required, or the gradient available.  The exception to
this is for the C-37A and C-20 aircraft, which have an adjustment available on the Takeoff /
Airport page, in the SID / DP box.  Thus, the military aircraft should perform the adjustment
when computing the takeoff, and only store the published SID gradient in the database.

Airport Identifier

Enter the 4-letter ICAO identifier, or the 3-letter IATA identifier.  Click on the ICAO or IATA button
to select which identifier has been specified.  Press Enter or click on the Retrieve button to
retrieve the airport from the database.  You may view the airport information by clicking on the
View button, either before or after pressing the Retrieve button.  When the airport has been
retrieved, the Airport / Runway Info box will contain the airport name and city, state, and
country.  The text on the Retrieve button will change color from red to green when an airport
has been read into memory.  Click the Search button to search for an airport in the database by
name, city, or location.

Runway

When the airport data are retrieved from the database, the runway identifier drop-down list is
filled with a list of the runways that are available for this airport in the database.  Select the
desired runway from this list by clicking on it or using the arrow keys to highlight your choice,
and then press Enter or click on the Retrieve button to retrieve the runway data from the
database, or the View button to retrieve the data and view it.  When the runway has been
retrieved, the Airport / Runway Info box will contain the runway identifier, length, and end
elevation.  The text on the Retrieve button will change color from red to green when a runway
has been read into memory.

SID

If you are entering a new SID, select Add New SID from the SID drop-down list.  To retrieve a
SID that has been saved in the database, after the runway has been retrieved, the SID drop-
down list will be filled with a list of the SIDs that have been saved for this runway.  Select the
SID you want to edit and press Enter.  The SID edit fields in the bottom half of the window will
be filled with the data for the SID.  At this point you may edit the data.

SID Identifier

Enter the name of the SID in the Name field, e.g. ELMOO5 or VNY7.  Names are limited to 6
characters.  Some airports have numerous SIDs, and multiple transitions for each SID, each of
which has a different minimum climb gradient associated with it.  If there is a transition for the
SID, enter the name of the transition in the Transition field.  Transitions are limited to 8
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characters.  If the transition name is longer than 8 characters, it will be truncated to 8.

SID Specification

Enter the required climb gradient in the Gradient field, and the altitude in feet up to which the
gradient must be maintained in the Up to Altitude field.  Climb gradient may be expressed in
feet per nautical mile (FT/NM) or percent (%).  Generally, civilian SIDs are expressed in FT/NM,
and this is the default.  If the value you enter for gradient appears not to match the units
selected, you will be prompted to confirm that this is indeed the input you want.  The gradient
will be converted to FT/NM and stored in that format, and will also be displayed elsewhere in
the program in FT/NM, but will always be shown here in the units in which it was entered.

Options Menu

Select Aircraft
 

To select an aircraft for use in making computations from the list of aircraft that you have
entered, use the Select Aircraft function on the Options menu.  You will be presented with a
drop-down list of aircraft in the database.  Click on desired aircraft to select it, and then click on
the OK button.  If you click on the Cancel button, the function will abort without making a
change.

Toggle Hints
 

When you place the cursor over an input or output field, most of them have built-in help text,
called hints, that pop up on-screen, and also at the bottom of the main program window on the
status line.  After you become familiar with the program, these hints may become annoying,
always popping up all over the place.  You may turn off the pop-up hints with the Toggle Hints
function on the Options menu.  If the menu item has a check mark beside it, hints are on, and if
not, they are off.  Click on the menu item to toggle between the two states.  Doing this only has
an effect until you exit the program.  If you want to make a permanent change, you may do so
with the Preferences function of the Options menu.  Note that if you turn off hints, only the pop-
up hints will be turned off.  All hints will still be displayed on the status line at the bottom of the
window.  This is true even for other windows or dialogs that are being displayed.  For example,
if the Runway Viewer is displayed, it overlays the main window.  You may move the runway
window to another location, and see the hints displayed on the main window's status line when
you pass the cursor over a value in the Runway Viewer.

Preferences

General
 

The Preferences function allows you to adjust the default values for program settings.  Access
the Preferences function from the Options menu.  When you have completed the changes,
click on the OK button to save the preferences and make them active in the program, or click
on Cancel to throw the changes away.
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Takeoff
 

Line Up Distance

This is the distance from the brake release end of the runway to the nosewheel.  Set the
amount of runway length to be set aside for line up distance, in feet.

Obstacle Envelope

Select the envelope to be used for computing obstacle clearance.  The FAA envelope is a
constant 600 feet wide, 300 feet each side of the runway centerline, regardless of the distance
an obstacle is from the end of the runway.  The ICAO envelope extends 295 feet (90 M) each
side of centerline at the end of the runway, and expands out at a ratio of 8:1 to a maximum of
1969 feet (600 M) after which it remains constant.  Each obstacle is evaluated based on the
offset from centerline, and only those that fall within the envelope are tested for clearance.  If
you have no legal requirement for one or the other, the ICAO methodology is more
conservative, since it will include obstacles that the FAA methodology does not consider and
allows for some drift from the extended runway centerline.

V1 Display

The takeoff results display will show any one of the three V1 values that are possible, V1Min,
V1Max, or V1 for balanced field length.  Select the one that you want displayed in the results. 
You may view all of the V1 values in the results screen by placing the cursor over the V1 value,
so they are all available to you after the calculation.

Landing
 

Distance

Select the distance that landing field length limited weight will be based on.  For FAR 91
operators, Landing Dist. is appropriate.  For FAR 135 and 121, or FAR 91 subpart K (fractional
ownership) operators, Intended Dry/Alt would be appropriate, to make the default condition be
the dry factored runway length.

FAR 91 Subpart K Factored Landing Field Length

Check this box to cause the landing field length factor of 0.8 to be applied to the Intended Dry
and Intended Wet field length calculations for FAR 91 subpart K (fractional ownership)
operators.  If left unchecked, the landing field length factor of 0.6, appropriate for FAR 135 and
121 operators, will be applied.

FAR 91 Unfactored Landing Field Length
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Check this box to use the FAR 91 unfactored landing field length calculations from the
Operational Information Supplement.  These are available only for Gulfstream V, IV-SP, and
550.  They are only available for flaps 39, with anti-skid operative and automatic ground
spoilers.  Refer to the OIS text for details and conditions of use.  For any calculation that can't
be handled using these data, the AFM data will automatically be substituted.

Units
 

Select the units you wish to have as defaults for temperature, altimeter setting, weight, and
wind speed.

Miscellaneous
 

Airport Identifier

Select which airport identifier type you wish to have as the default.  Note that all airports in the
worldwide airport database have ICAO identifiers.  There are a large number of airports that
have no IATA identifier associated with them, so it is recommended that you make ICAO the
default.

Center Screen

If this is checked, whenever the program is started, the program window will be centered in the
computer screen.  If it is not checked, the window will be placed where it was the last time the
program was executed.

Show Hints

If this is checked, the pop-up hints will be activated, and each time the cursor is placed over an
item that has a hint associated with it, the hint will be displayed both on the status line at the
bottom of the main window, and in a pop-up hint attached to the tail of the cursor.  If
unchecked, hints will be shown only on the status line.

Save On Exit

If this is checked, the configuration of the program is saved each time the program exits, and
will be reinitialized to those settings at the next execution.  If not checked, the program settings
will not be saved.

Printer Character Size

Enter the desired printer character size for printed output, in points.  The default value is 12. 
Some printers may require an adjustment due to having wider margins which would force the
output to spill over onto a second page.  Setting a smaller point size will allow the information to
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fit onto one page.

Alternate Search Criteria

Enter the maximum distance in nautical miles and minimum length of longest runway in feet, to
be used as the default values for the alternate search feature of the airport search dialog.

Toolbar
Define the functions assigned to the toolbar buttons.  You may arrange the toolbar buttons in
any desired order by selecting the function for each button.  Every function must be assigned to
a button, and no function may be assigned to more than one button.  This will be checked when
the OK button is clicked, and you will be asked to make changes if needed.

Help Menu

Help Topics
 

Online help is available by selecting the Help Topics function from the Help menu.  The
complete documentation is available online, organized by topic.  You may also search the
documentation for any word that appears in it.  This capability will provide you with all of the
information that is in this document, without having to carry the printed documentation with you.

About
 

The About box displays information about the program.  In addition to the usual program name
and copyright that are found in most other software, you will find the versions of the program
and worldwide airport database, customer name and number, the active aircraft type and
certification basis, and the revision number and dates of the Airplane Flight Manual and other
manuals that make up the aircraft database.  This is the place to go to determine the revision
status of the software.  Dismiss the About box by clicking on the OK button.

Contact
 

From time to time, you may need to contact Gulfstream for customer support or Tybee Jet for
technical support.  Select the Contact function from the Help menu, and you will see a dialog
that provides you with several methods of contacting us.  The Tybee Jet website and support
email address have been turned into live links.  If you click on the underlined internet
addresses, and you have a default web browser or email program specified in the Windows
Registry, the default web browser or email program (as appropriate) will be launched, and take
you to the Tybee Jet website, or begin editing an email message.  You will, of course, have to
be connected with access to your internet service provider for this to function.  Dismiss the
Contact box by clicking on the OK button.
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View the Tybee Jet website at: www.tybeejet.com 

Contact Gulfstream Technical Publications for customer support by the following means:

Phone: 912-965-3204

Mail: Gulfstream Aerospace

Technical Publications

P.O. Box 2206    M/S C-20

Savannah, GA  USA  31402

Contact Tybee Jet for technical support by the following means:

Phone: 615-308-7216

Mail: Tybee Jet Corporation

644 Logwood Briar Circle

Brentwood, TN  USA  37027

Miscellaneous

Windows Font Size
 

The Windows operating system allows the user to select from two font sizes, known as "Large
Fonts" and "Small Fonts", by right clicking on the Windows desktop, selecting "Properties" from
the menu, clicking on the "Settings" tab, and selecting either font size from a combo box.  (For
Windows XP, click the "Advanced" button on the "Settings" tab, then select either "Normal size
(96 DPI)" or "Large size (120 DPI)".)  AFMatic has been designed using "Small Fonts",
however, it will scale properly if you select "Large Fonts".  It is possible that on some computer
systems, some of the visual elements of AFMatic will not scale properly with "Large Fonts".  If
you encounter a problem with scaling when using "Large Fonts", please provide us with a
report of the problem so that we can track it down and correct it.

Data Integrity
 

All the computation power in the world is of no use if the data that form the basis of the
computations are not valid.  To ensure the integrity of the worldwide airport database, the
aircraft data from the Airplane Flight Manual, and the program executable itself, AFMatic
incorporates a mathematical algorithm, known as a Cyclic Redundancy Check, or CRC.  The
CRC is computed for the program executable and the aforementioned data files each time the
program is executed, and compared with the CRC value that was computed when these files
were created.  If so much as a single bit in a single byte in any of these files has been changed,
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the program will display a message alerting you to the fact that the file integrity has been
compromised, and instructing you to reinstall the software.  At that point, AFMatic will
terminate.  You must reinstall the application to restore the files to their proper form, or
alternately, if you made a backup immediately after installing the application, you may restore
the files from the backup.  This file integrity check provides protection from virus attack, as well
as accidental corruption of the files.

Web Sites Of Interest
 

The wealth of information available on the Internet must not be overlooked.  In addition to web
sites that are directly related to Tybee Jet and the operation of AFMatic, there are some closely
related sites of interest.

The Tybee Jet Corporation web site has information regarding AFMatic:

www.tybeejet.com 

The Gulfstream Aerospace Corporation web site has information regarding Gulfstream
products and services:

www.gulfstream.com 

The Boeing web site is an excellent source of information regarding airport noise restrictions at
airports throughout the world.  It also has general information about noise regulations.  If noise
restrictions are a concern for your operations, this is a valuable resource:

www.boeing.com/commercial/noise/list.html 

Software License Agreement
 

You should carefully read the following terms and conditions before using this product.  It
contains software, the use of which is licensed by Tybee Jet Corporation ("Tybee Jet") to its
customers for their use only as set forth below.  If you do not agree to the terms and conditions
of this agreement, do not use the software.  Using any part of the software represents an
acknowledgement that you accept these terms.

LICENSE:  In consideration of Tybee Jet granting you a nonexclusive license to use the
accompanying software program(s) (the "Software"), you agree to be subject to the terms and
restrictions to be set forth in this License Agreement.  You are not permitted to lease, rent,
distribute, or sublicense the Software, or to use the Software in a time-sharing arrangement, or
in any other unauthorized manner.  Further, no license is granted to you in the human readable
code of the Software (source code).  Except as provided below, this License Agreement does
not grant you any rights to patents, copyrights, trade secrets, trademarks, or any other rights in
respect to the Software.
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The Software is licensed for use in support of a single airplane, by serial number.  An additional
license must be purchased for each aircraft to be supported.  You may use the Software on
any workstation or any network server owned by or leased to you, provided that the Software is
used only in support of one aircraft per license purchased by you.  You may reproduce and
provide one (1) copy of the Software and supporting documentation for each such workstation
or network server on which the Software is used as permitted hereunder.  Otherwise, the
Software and supporting documentation may be copied only as essential for backup or archive
purposes in support of your use of the Software as permitted hereunder.  You must reproduce
and include all copyright notices and any other proprietary rights notices appearing on the
Software and the supporting documentation on any copies that you make.

TITLE:  All title and copyrights to the Software (including any images, photographs, animations,
video, audio, and texts incorporated into the software), the accompanying printed materials,
and any copies of the software, are owned by Tybee Jet.  You may not copy the printed
materials accompanying the Software, except as permitted in this License Agreement.

NO ASSIGNMENT:  You may not transfer or assign the Software and/or this License
Agreement to another party without the prior written consent of Tybee Jet.  If such consent is
given and you transfer or assign the Software and/or this License Agreement, then you must at
the same time either transfer any copies of the Software as well as the supporting
documentation to the same party or destroy any such materials not transferred.  Except as set
forth above, you may not transfer or assign the Software or your rights under this License
Agreement.

NO REVERSE ENGINEERING:  Modification, reverse engineering, reverse compiling, or
disassembly of the Software is expressly prohibited.  However, if you are a European
Community ("EC") resident, information necessary to achieve interoperability of the Software
with other programs within the meaning of the U.K. Copyright (Computer Program) Regulations
1992 implementing the EC Directive on the Legal Protection of Computer Programs is
available to you from Tybee Jet upon written request.

EXPORT RESTRICTIONS:  You agree that you will not export or re-export the Software or
accompanying documentation (or any copies thereof) or any products utilizing the Software or
such documentation in violation of any applicable laws or regulations of the United States or the
country in which you obtained them.

TRADE SECRETS:  You acknowledge and agree that the structure, sequence, and
organization of the Software are the valuable trade secrets of Tybee Jet and its suppliers.  You
agree to hold such trade secrets in confidence.

UNITED STATES GOVERNMENT LEGENDS:
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For units of the Department of Defense:

The Software is commercial computer software as defined in 48 CFR 211 and therefore is
provided to units of the Department of Defense under the terms of this License Agreement,
which is Tybee Jet's standard commercial agreement for the Software.  In the alternative, if 48
CFR 211 is not invoked, the Software is licensed as follows:  Restricted Rights Legend:  Use,
duplication, or disclosure by the United States Government is subject to restrictions as set forth
in subparagraph (c)(1)(ii) of the Rights to Technical Data and Computer Software Clause of 48
CFR 52.227-7013.  Tybee Jet Corporation, 644 Logwood Briar Circle, Brentwood, TN  USA 
37027.

For civilian agencies:

Restricted Rights Legend:  Use, reproduction, or disclosure is subject to restrictions set forth in
subparagraph (a) through (d) of the Commercial Computer Software - Restricted Rights
clause of 48 CFR 52.227-19 and the limitations set forth in Tybee Jet's standard commercial
agreement for the Software.  Unpublished rights reserved under the copyright laws of the
United States.

TERM AND TERMINATION:  This license will expire one (1) year from the effectivity date of the
first release of the Software which you receive as part of your annual subscription to updates, if
it is not earlier terminated.  It may be renewed annually, for a period of 1 year, by subscription. 
You may terminate it at any time by destroying the Software and documentation together with
all copies and merged portions in any form.  It will also terminate immediately if you fail to
comply with any term or condition of this License Agreement.  Upon such termination, you
agree to destroy the Software and documentation, together with all copies and merged portions
in any form.

GOVERNING LAW:  This License Agreement shall be governed by the laws of the State of
Tennessee as such laws are applied to agreements entered into and to be performed entirely
within Tennessee between Tennessee residents and by the laws of the United States.  You
agree that the United Nations Convention on Contracts for the International Sale of Goods
(1980) is hereby excluded.

USE IN AIRCRAFT OPERATIONS:  The Software is provided as an alternative to manual
calculations based on the content of the Airplane Flight Manual and supporting documents. 
Every effort has been made to ensure that the Software accurately reproduces these
computations.  HOWEVER, IT REMAINS THE SOLE RESPONSIBILITY OF THE PILOT IN
COMMAND TO OPERATE THE AIRPLANE WITHIN THE RESTRICTIONS OF 14 CFR 91, 14
CFR 135, OR 14 CFR 121, AS APPLICABLE, REGARDLESS OF THE ACCURACY OF THE
RESULTS OF COMPUTATIONS PERFORMED BY THE SOFTWARE.
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LIMITED WARRANTY:  Tybee Jet warrants the physical media and physical documentation
provided by Tybee Jet to be free of defects in materials and workmanship for a period of ninety
(90) days from the original purchase date.  If Tybee Jet receives notification within the warranty
period of defects in materials or workmanship, and determines that such notification is correct,
Tybee Jet will replace the defective media or documentation.  The entire and exclusive liability
and remedy for breach of this limited warranty shall be limited to replacement of defective
media or documentation and shall not include or extend to any claim for or right to recover any
other damages, including but not limited to, loss of profit, data, or use of the software or
special, incidental or consequential damages, or other similar claims, even if Tybee Jet has
been specifically advised of the possibility of such damages.  In no event will Tybee Jet's
liability for any damages to you or any other person ever exceed the lower of the list price or the
actual price paid for the package or the license to use the software, regardless of the form of
the claim.

TYBEE JET SPECIFICALLY DISCLAIMS ALL OTHER WARRANTIES, REPRESENTATIONS,
OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO, ANY
IMPLIED WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE.  ALL OTHER IMPLIED TERMS ARE EXCLUDED.

Specifically, Tybee Jet makes no representation or warranty that the software or
documentation are "error-free", or meet any user's particular standards, requirements, or
needs.  In all events, any implied warranty, representation, condition, or other term is limited to
the physical media and documentation and is limited to the 90-day duration of the limited
warranty.

Tybee Jet assumes the responsibility of accurately processing the worldwide airport database
from the format in which it is delivered into the format that is used by the Software. 
HOWEVER, TYBEE JET MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED, AS
TO THE ACCURACY OF THE WORLDWIDE AIRPORT DATABASE, INCLUDING
WARRANTIES OF MERCHANTABILITY OR OF FITNESS FOR A PARTICULAR PURPOSE. 
UNDER NO CIRCUMSTANCES SHALL TYBEE JET BE LIABLE FOR INDIRECT,
INCIDENTAL, CONSEQUENTIAL, OR OTHER DAMAGES FROM ALLEGED NEGLIGENCE,
BREACH OF WARRANTY, STRICT LIABILITY OR ANY OTHER THEORY, ARISING OUT OF
THE USE OF THE WORLDWIDE AIRPORT DATABASE.

SEVERABILITY:  In the event any provision of this License Agreement is found to be invalid,
illegal, or unenforceable, the validity, legality, and enforceability of any of the remaining
provisions shall not in any way be affected or impaired and a valid, legal, and enforceable
provision of similar intent and economic impact shall be substituted therefore.

ENTIRE AGREEMENT:  This License Agreement sets forth the entire understanding and
agreement between you and Tybee Jet, and may be amended only in writing, signed by both
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Tybee Jet Corporation

644 Logwood Briar Circle

Brentwood, TN  USA  37027

(615)-308-7216
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